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1 Overview
HPERecovery Manager Central for SQL (RMC-S) allows SQL database administrators to create,
schedule, and manage SQL-application consistent snapshots on HPE 3PAR StoreServ.
Additionally, the RMCExpress Protect feature enables automatic flat backup of SQL data volumes
from HPE 3PAR StoreServ to HPE StoreOnce, independent of backup server software. The
backups are self-contained volumes that can be restored back to the original or different HPE
3PAR StoreServ in the event of a disaster.

Features supported
• Volume Shadow Copy Service supports Full backup type, copy-only backup type for

secondary AlwaysOn databases.
• Virtual Copy operations on SQL instance and database level.

• Policy creation.

• Virtual Copy creation of Availability Group databases in Microsoft SQL Server 2012, 2014.

• Scheduling and management of automated tasks.

• Mount Virtual Copies locally or remotely.

• Mount Virtual Copies in read-write mode.

• Unmount Virtual Copies.

• Delete Virtual Copies.

• Environment Report.

• File Copy restore.

• Database level file restore in No Recovery mode.

• Selective restore of databases from instance level virtual copy.

• Automate the point of failure restoration process.

• Attach or detach a database to any SQL server during mounting or unmounting operations.

• Restore from Virtual Copies.

• Protect using HPE StoreOnce, HPE Data Protector or Symantec NetBackup, or Symantec
Backup Exec.

• Database cloning.

• Restore from protects using HPE StoreOnce, HPE Data Protector, Symantec NetBackup,
or Symantec Backup Exec.

• RMC-S GUI.

• Recovery Manager CLI.

• Volume restore.

• Virtual Copy creation of local and remote Microsoft SQL Server instances and databases.

• Failover cluster environment.

• Remote Copy in synchronous mode, asynchronous mode, or asynchronous periodic mode.

• Virtual Lock of an instance and its Virtual Copies.

• Autonomic groups (Volume Sets).
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• Manage production servers having different versions of SQL servers with single interface
server.

• Support for Virtual Fiber Channel (VFC) in production server and interface server.

• Support for VMs running on Microsoft Hyper-V Hypervisor and VMware ESX(i) with SQL.

• Support for interface server and production server onMicrosoft Hyper-V and VMware ESX(i)
VMs in iSCSI environment.

• Support for HPE 3PAR Cluster Extension (CLX) configuration.

• Support for coexistence with HPE 3PAR Recovery Manager for Exchange software.

• Support for interface server and production server running in VMware VMDirect Environment.

• Support for basic GUID Partition Table (GPT) disks.

• Support for SQL database residing on Volume Mount Point (HPE 3PAR volume mounted
on a system drive or another HPE 3PAR volume).

• Support for concurrent virtual copy or remote virtual copy creations, concurrent backup jobs,
and concurrent Virtual Copy or remote Virtual Copy creation with interface jobs.

• Protection of different databases using HPE StoreOnce, Symantec NetBackup, Symantec
Backup Exec, or HPE Data Protector can be taken concurrently. For example, protect of
database db1 using Symantec NetBackup and backup of database db2 using HPE Data
Protector can execute in parallel.

• Support for HPE 3PAR StoreServ 8xxx and 20xxx series.

NOTE:
• Due to a SQL instance limitation, the recommended maximum number of databases for

which you can create snapshot backups at the same time is 35.
For more information, see Microsoft KB 943471: http://support.microsoft.com/kb/943471

Features not supported
• Microsoft SQL Server offline backup.

• VSS backup types Incremental, Differential, and Log.

• All protects tools except HPE StoreOnce, HPE Data Protector, Symantec NetBackup, and
Symantec Backup Exec.

• Access to HPE 3PAR StoreServ Storage System via SSH.

• Taking a snapshot of the SQL servers created with SQL Server Authentication set to
mixed-mode authentication mode.

• Taking a snapshot of a database residing on a network mapped volume.

• Virtual copy ownership transferring.
For example, you can remove Virtual Copies only if you created them, and you can unmount
Virtual Copies only if you mounted them.

• Taking a snapshot of an instance or a database that resides on dynamic disks.

• Mounting Virtual Copies to a Windows Fibre channel (FC) based host that resides in virtual
environment.

• Performing a restore on a Windows Fibre channel based host that resides in virtual
environment.

• Performing a mount, an unmount, or a restore function in Raw Device Mapping (RDM) disk
and passthrough disk.

8 Overview
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• Remote Copy is not supported for availability databases.

• RMC-S does not support Availability databases when any of the Availability Group replicas
is a part of a SQL cluster.

• Backup of different databases with same policy cannot be taken using Symantec NetBackup.
Concurrent backups with different policies can be taken.

• Protects of different databases with same datalist cannot be taken using HPE Data Protector.

• Protects of different databases with same device name cannot be taken using Symantec
Backup Exec.

• A database protect is not allowed when a backup of its instance is in progress. Similarly, an
instance backup is not allowed when a backup of the database is in progress.

• RMC-S does not support Availability Group databases received from multiple StoreServs.

• Customizing date format RMC-S supports date format in month/day/year.

• Windows automount feature if the database or an instance LUN is on a mountpoint residing
on a mountpoint volume.

• RMC-S does not support Host Sets and Domain Sets.

• RMC-S does not support any language other than English for domain, instance, database,
and path names.

Supported environments
For more information on the supported hardware and software platforms, see the SPOCK for
HPE Storage Products.

Supported environments 9
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2 Installation and deployment scenarios
This chapter explains the installation and the different deployment scenarios of RMC-S.

Prerequisites
Before starting the deployment, make sure that the system and license requirements are met.
For more information on the supported environment, hardware, and software platforms, see
SPOCK for HPE Storage products.

Installing RMC-S
This section discusses the following procedures:
• Installation

• Verifying the installation

• SSL certificate verification

• Creating OpenSSL v3 certificate

• Upgrading RMS to RMC-S

• Uninstallation

Installation steps
This section describes install RMC-S components on the production and interface servers.
1. Navigate to the folder containing the RMC-S installer and double-click the

HPE_RMCS_2.0.2.exe.
2. Read the information provided on theWelcome window and click Next.

The License Agreement window appears.
3. Read the end-user license agreement, select I accept the terms in the license agreement,

and click Next.
The Destination Folder window appears.

4. Click Next to install RMC-S to the default folder (<default drive>:\Program Files\
HPE\RMC-S\).
The Custom Setup window appears.

NOTE:
• If you install RMC-S to a different folder, click Change and select the required folder.

• RMCVSS provider installs by default in <default drive>:\Program Files\HPE\
RMC\Provider.

5. Choose one of the following installation types:
• Recovery Manager Agent for SQL Server—To install the agent component of RMC-S

on the production server. By default, this is selected and cannot be deselected.
• Recovery Manager for Interface Server—To install the server component of RMC-S

on the interface server.
TheWeb Extension Port Configuration window appears.

6. Specify a valid port number inWeb Service Port.
By default, port number 50001 appears. However, if required you can change it. For
information on the supported range of port numbers, see “Changing RMC-S TCP/IP port”
(page 15).
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NOTE: If you are installing the Recovery Manager SQL server component on the
interface server then you must provide the web service port number.

7. Enable the check box Configure Web Service using HPE provided SSL certificate to
configure the certificate.
The SSL certificate enforces certificate validation by the host (RMC) and client application
(interface server) to establish a secure connection.

NOTE:
• If the check box is unchecked, make sure to use your own OpenSSL version 3 certificate

and bind it to the web port.
• Web server port is used for communication between RMC and the interface server to

establish secure connection.

8. Click Install to start installation.
9. Click Finish to complete the installation.

Verifying the installation
1. Click Control Panel→ Programs→ Programs and Features.
2. Verify that the following components are available:

• HPE Recovery Manager Central VSS Provider v2.0.2

• HPE Recovery Manager Central for Microsoft SQL Server v2.0.2

Verifying the SSL certificate
1. Click Start and type mmc.exe in Search.

Console 1 window appears.
2. Click File→ Add/Remove Snap-in.

Add or Remove Snap-ins window appears.
3. Click Certificates snap-ins and click Add > .

Certificates snap-ins window appears.
4. Select the option Computer account and click Next.

Select Computer window appears.
5. Click Finish with the default options.
6. Click OK in the Add or Remove Snap-ins window.
7. Click Certificates (Local Computer)→Personal→ Certificates.

HPE RMC for SQL with the details appear on the right pane.

Steps to create OpenSSL v3 certificate and binding to web port
Open SSLv3 certificate is created only when you want to create and use your own certificate.
Run the following commands to create a certificate:
1. openssl genrsa -des3 -out rmcs_interface_server.key 1024.
2. openssl req -new -x509 -days 1001 -key rmcs_interface_server.key

-out rmcs_interface_server.cer
3. openssl pkcs12 -export -in rmcs_interface_server.cer -inkey

rmcs_interface_server.key -out rmcs_interface_server.pfx
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Steps to import certificate to Windows store
1. Install the certificate in service account by selectingMMC→ Add Snap-in→ Certificates→

Computer Account.
2. Select the store to install the certificate.
3. Right-click on the store All tasks→ Import .
4. Add the .pfx certificate file generated as mentioned in Step-3 in Open SSLv3 certificate.

Binding the certificate to web port
1. If the port is already bound with another certificate, delete the old binding.

http delete sslcert ipport=0.0.0.0:[port no]

2. Bind the certificate to the port.
netsh http add sslcert ipport=0.0.0.0:[port no] appId={GUID}
certhash=[thumbprint of the certificate]

Verification
• Run the following command:

netsh http show sslcert ipport=0.0.0.0:[port no]

Testing SQL connectivity
To verify that your SQL instances are reachable after you install and configure RMC-S on the
interface server and all of the production servers:
1. Log onto the interface server as the system administrator.
2. Launch SQL Server Management Studio.
3. In the Connect to Server window, enter or select the following:

Server type: Database Engine

Server name: Enter the server and instance name as follows:

• For the default instance, enter the name of your SQL server. For example,
Server name: Bottlenosed

• For a named instance, enter the name of your SQL server and the name of your SQL
instance in the format: <SQLserverName>\<instanceName>. For example:
Server name: Bottlenosed\MSDE_VC

Authentication: Windows Authentication
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4. Click Connect.
The following window appears:

Upgrading and migrating RMS to RMC-S
You can upgrade the existing RMS to RMC-S 2.0.2 or RMC-S 2.0.0 to RMC-S 2.0.2. Also, RMC-S
agents must be upgraded when RMC GUI is upgraded.
For more information on upgrading to RMC-S, see theHPERecovery Manager Central Upgrading
and Migration Guide.

Uninstalling RMC-S
1. Click Control Panel→Programs→ Programs and Features.
2. Select and uninstall the following components:

• HPE Recovery Manager Central VSS Provider v2.0.2

• HPE Recovery Manager Software for Microsoft SQL Server v2.0.2

NOTE: Uninstalling RMC-S does not remove HPE folder as the folder contains data and log
file that may be necessary for verifying the SQL repository and log files.

RMC-S installation scenarios
The RMC-S installation components are:

• Agent component—Agent/Client is light weight component that is installed on a production
server. This component must be installed on the same server where the SQL server is
installed.

• Interface Server Component—Interface/Server component is a management component.
This component enables you to use the CLI commands for RMC-S on an Interface server.
This can optionally backup snapshots to a Symantec NetBackup media server, BackupExec,
or HPE Data Protector. Typically, this is installed on separate server other than the SQL
production server. This component can also be installed on SQL production server depending
on the data load on SQL server.
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Some sample examples on how the component must be installed.

Components installedScenarios

1 • Install the SQL production server with RMC-S Agent installed.

• Same SQL production server or Separate Windows machine with RMC-S Agent and
interface server installed.

SQL production server with RMC-S agent, interface server installed on the samemachine.2

3 • In a Remote Copy setup, have the RMC-S agent component installed on the SQL
production server.

• You must have two separate interface servers, local and remote. Install the RMC-S
agent, interface server component on the interface server.

• You can use any of the existing SQL production server as interface server if data load
on SQL server is not a concern.

4 • Install AAG setup having multiple SQL production servers and one interface server.

• Install RMC-S agent component on all SQL production servers.

• Install RMC-S agent, Interface server component on the interface server.

Deployment scenario
RMC-S can be deployed in the following scenarios:

• Scenarios — 1: Configuring RMC-S for stand alone environment

• Scenarios — 2: Configuring RMC-S for AlwaysOn Availability Group (AAG)

• Scenarios — 3: Configuring RMC-S in a Microsoft failover cluster environment

• Scenarios — 4: Configuring RMC-S in an HPE 3PAR Remote Copy environment
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3 Configuring RMC-S
Configuring the SQL Database

When you configure the SQL database:

• Use database files and transaction logs created on basic disks using the NTFS or GPT file
system.
RMC-S does not support other types of disks.

• Maintain a 1:1 relationship between databases and volumes.

Avoid adding more than one database plus its transaction log files to a volume.◦
◦ Avoid adding files from a database to multiple volumes.

CAUTION: Be sure to maintain a single database : single volume relationship.
If you add multiple databases to one volume, backup, and disaster recovery operations on one
database can result in conflicts between the databases in the volume.

Configuring RMC-S
Installation location

For fresh installation, the location is:
<default drive>:\Program Files\HPE\RMC-S folder.

Search path
After installation, you can instantly issue RMC-S CLI commands from any directory. Although
RMC-S executable is installed in a fixed location that is specified during installation, the location
is automatically added to the Windows PATH environment variable.

NOTE: If the interface server is installed remotely, then it is recommended to log off and log
in to the interface server and set the Windows path environment variable.

Changing RMC-S TCP/IP port
RMC-S interface server uses 50001 to run the web service and it is the default 50001 default
port to run web service.
If the port 50001 is not available, you can use any available port from 50001–52000.
1. Select an available port. The valid TCP/IP port range is 50001 to 52000.
2. Log in to the Interface Server, and use the HpRmCli portconfig command to change

the web service port.
3. Bind the certificate to the web port. For more information, see Steps to create OpenSSL v3

certificate and binding to web port.
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4. Log in to RMC GUI and select option Add Interface Server in the Port field, change the
port number you set for web service to run while installing RMC-S component in the interface
server.
From the Windows Service console, restart the HPE RMC for Microsoft SQL service.

NOTE:
• If the user changes the web service port from default 50001 to a new port, you must

use the same port number in RMC GUI when you register the interface.
• Port 9932 is used by .NET Remoting and is used by the interface server for agent

communication.
• Make sure that the newly added port is open for incoming request and outgoing response.

Changing a production server port from the interface server
1. On the interface server, run the following command:

hprmcli sql portconfig -s <production_server> -r <sqlport/WebPort>
-n <port_number>

2. On the production server, restart the HPE RMC for Microsoft SQL service.

Configuring RMC-S policies
• To use RMC-S GUI to set SQL server instance and database policies, see “Working with

RMC-S graphical user interface” (page 40).
• To use RMC-S CLI to set SQL server instance and database policies, see “Using RMC-S

Command Line Interface” (page 68). Also, see HpRmCli Sql policy command.

Configuring Mount functionality
The Windows automount feature is not compatible with RMC-S. To ensure that the Windows
automount feature is disabled:
1. Open a command prompt (cmd) window.
2. Enter: diskpart
3. At the DISKPART prompt, enter: automount disable
4. Exit the command prompt window.

Managing SQL Servers across multiple active directory domains
If you are configuring RMC-S to work with SQL Servers across multiple active directory domains,
you must store the appropriate login and password in the Windows user account on the interface
server.
1. On the interface server:

• In Windows 2008, click Start→Control Panel→User Accounts and clickManage your
network passwords.
In the Stored User Names and Passwords dialog box, click Add.

• In Windows 2008 R2, click Start→Control Panel→User Accounts and then click
Manage your credentials→Add a Windows credential.

2. In the Log on to field (or, for Windows 2008 R2, the Internet or network address field),
enter the network location to which you want automatic access.
You can use a wildcard if you want access to multiple computers on a domain. For example:
*.<domain_name>
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3. Enter the appropriate login and password.
4. Repeat these steps for all SQL Server domains in RMC-S configuration.

NOTE:
• Make sure that you add the FQDN while registering the server.

• If you do not configure RMC-S, then you might encounter unspecified error when executing
RMC-S operation.

Configuring RMC-S for Standalone environment
RMC-S supports Microsoft SQL Server for stand alone environment.

Figure 1 RMC-S for Standalone environment

Configuring RMC-S for Availability Group
RMC-S supports Microsoft SQL Server 2012 and 2014 Availability Group databases. In this
configuration, each availability group replica is connected to only one StoreServ and the StoreServ
can be same or different from that of other replicas.
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Figure 2 RMC-S with Three Availability Replica Nodes

In Figure 2 (page 18), RMC-S is configured with two availability replica nodes. The configuration
can be extended up to five replica sites, one primary replica node and up to four secondary
replica nodes. Snapshot can be created for availability database on primary replica node only
through the RMC-S interface server 1 and snap shot for availability database on secondary
replica node can be created only through RMC-S interface server 2. If both primary and secondary
replica nodes are connected to the same HPE 3PAR StoreServ, then any interface server can
be used to create a snap shot.
Before you start configuring RMC-S for Availability Group:

• Make sure all the prerequisites for Availability Group are met before discovering Availability
Group in RMC-S. For list of prerequisites, see http://msdn.microsoft.com/en-us/library/
ff878487%28v=SQL.110%29.aspx.

• Make sure all the nodes participating in the Availability Group are part of the sameWindows
cluster and user has a Domain account and is an administrator for the system.

WARNING! Do not make any change in the Availability Group configuration while RMC-S
operations are in progress. Otherwise, the results may be unpredictable.

NOTE: If there is any change in the configuration of Availability Group, user must perform a
manual rescan in RMC-S.
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Grouping Volumes into Autonomic Groups
You can group virtual volumes into a volume set group.

Volume Sets
To configure volume sets:

• In a volume set, place one of the following:

◦ One database and its log files

◦ One instance and its related files

NOTE:
• Do not place one volume in more than one volume set.

• Do not place unrelated volumes in a volume set.

Configuring RMC-S in a Cluster environment
Cluster environment is deployed by enterprise customers to scale for failover support. It is highly
critical to monitor all nodes within the cluster. For example, if you have a 4 node cluster, it is
acceptable if 3 nodes out of this cluster are active. If one node in this cluster is down for any
reason, the user is notified with the appropriate message.

Figure 3 Cluster environment
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Configuring RMC-S in a Remote Copy environment
HPE 3PAR Remote Copy Software helps you to safeguard against disasters that might occur at
one location, by allowing you to keep copies of data on a separate server which can be placed
at a remote location. For example, if there were a fire or earthquake at one location, all of the
data stored there could be lost unless a backup copy can be recovered from a separate location
not affected by the disaster. RMC VM must have network interface configured with valid IP
address and subnet for Remote Copy.

NOTE: Make sure source and target RMC VSAs Network Interface -1 is configured with valid
IP address for Remote Copy to function with RMC-S. For more information on how to configure
multi NIC, see HPE Recovery Manager Central version 2.0.2 User Guide.

For more information, see Remote Copy for RMC-S.

Nonsynchronous long distance configurations
This section describes Remote Copy configuration for non-synchronous long distance (non-SLD)
configurations.

Figure 4 Remote Copy non-SLD configuration

1. Install RMC-S 2.0.2 on both source and target SQL Servers.
a. Deploy RMC VM-I and RMC VM-II as shown in Figure 4 (page 20).
b. Add source storage system to RMC VM-I.
c. Add target storage system to RMC VM-II.

2. Add remote appliance from RMC VM-I.
• Log in to RMC VM-I and click HPE Recovery Manager Central→Remote

Appliance→[+ Register Appliance ].
3. Register the source interface server on RMC VM-I.
4. Register the target interface server on RMC VM-II.

20 Configuring RMC-S



NOTE: To view or mount remote copy snapshots from target interface server:
• From the RMC-S GUI, you must manually register the remote copy related instance or

database with the Remote Copy option selected on the target interface server.

Synchronous long distance configurations
This section describes migration of Remote Copy snapshots for synchronous long distance (SLD)
configurations.

Figure 5 Remote Copy SLD configuration

1. Navigate to the folder containing the RMC-S installer, double-click the
HPE_RMCS_2.0.2.exe, and perform the following steps:
a. Install RMC-S 2.0.2 agent on the source application server.
b. Install RMC-S 2.0.2 agent and interface on the source interface server.
c. Install RMC-S 2.0.2 agent on the target 1 application server.
d. Install RMC-S 2.0.2 agent and the interface on target 1 interface server.
e. Install RMC-S 2.0.2 agent on the target 2 application server.
f. Install RMC-S 2.0.2 agent and the interface on target 2 interface server.

2. Perform the following steps to deploy RMC VMs:
a. Deploy RMC VM-I, RMC VM-II, and RMC VM-III as shown in Figure 5 (page 21).
b. Add the source storage system to RMC VM-I.
c. Add the target 1 storage system to RMC VM-II.
d. Add the target 2 storage system to RMC VM-III.
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3. Perform the following steps to add the remote appliance:
a. Log in to RMCVM-I and clickHPERecoveryManager Central→RemoteAppliance→+

Register Appliance.
b. Add RMC VM-II as a remote appliance.
c. Add RMC VM-III as a remote appliance.

4. Register the source interface server on RMC VM-I.
5. Register the target-1 interface server on RMC VM-II.
6. Register the target-2 interface server on RMC VM-III
7. From RMC VM-I, click HPE Recovery Manager Central→ Interface Servers→ Actions

→Migrate.
8. Similarly add RMC VM-II and VM-III.

NOTE: To view or mount the remote copy snapshots from target I or II interface servers, you
must manually register the remote copy related instance or database with the Remote Copy
option selected using RMC-S GUI on target I and II interface servers.

Recommendation (Optional)
In the following scenarios, the new remote copy snapshot creation or scheduled job snapshot
creation might fail and display an error message:

• If you have SLD Remote Copy group associated with an instance or database, then you
must set the default storage system using RMC registration tool on target interface if both
the target HPE 3PAR storage systems are managed by the RMC of target interface server.

• If only one target HPE 3PAR storage system is managed by target interface server RMC,
then you need not set the default storage system using RMC registration tool. You can ignore
this step.

Configuring the host computer and the HPE 3PAR StoreServ Storage
System

For information about configuring the HPE 3PAR StoreServ Storage System to communicate
with the host computer, see the HPE 3PAR StoreServ Storage Concepts Guide (OS 3.2.1 and
above) and the HPE 3PAR Command Line Interface Administrator’s Manual.

NOTE: The HPE 3PAR StoreServ Storage System source volumes used by RMC-S must be
base volumes. RMC-S cannot use physical copies or snapshot as source volumes.

Link and launching RMC-S GUI from MS SQL Studio
You can integrate or launch the HPE RMC-S GUI from the MS SQL studio by using the Add-in
feature.
To launch the appliance:
1. Close the MS SQL Management Studio GUI.
2. Run the batch script (first time only) placed in the interface server location <installed

directory>:\Program Files\HPE\RMC-S\SQL\setup_HPStoreOnceRMCSQL_addin.
or
For Upgrade—The location is <installed directory>:\Program Files\3par\RM\
SQL\setup_HPStoreOnceRMCSQL_addin.

3. Launch HPE RMC GUI as shown in Figure 6 (page 23).
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Figure 6 Link and launch

4. You can also launch the HPE RMC GUI from the Tools menu as shown in Figure 7 (page
23).

Figure 7 Link and launch — Tools

Link and Launch
Link and Launch helps to launch the RMC SQL GUI from the MS SQL Management Studio 2012
or 2014 GUI.

Limitations
• Link and Launch is not supported for MS SQL Management Studio 2008 GUI.

• Do not remove or unload the HPE toolbar or menu option containing the link RMC Link and
Launch. If removed, the Link and Launch MS SQL Add-in fails to reload or might behave
unexpectedly.

• This is a third party extension to SQL Server Management Studio. Microsoft does not support
such extensibility, so there may be issues with backward/forward compatibility. For more
information on the support extensibility, click the following link:
For SQL server 2012

• Microsoft does not support SQL Server Management Studio installations with SQL Server
Management Studio extensions present, so if you have installed SQL Server Management
Studio extensions, youmay want to remove them before calling Microsoft Customer Support
about a SQL Server Management Studio issue.

• Remove the extension before upgrade.
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4 Configuring Protect Software
Overview

RMC-S can be used with either HPE StoreOnce, HPE Data Protector, Symantec NetBackup, or
Symantec Backup Exec to protect and restore the snapshot created by RMC-S.
If you are using protect software in the backup environment, you must install a protect master or
a protect client, or a protect media on the interface server.

NOTE: For information about the supported versions of HPE StoreOnce, HPE Data Protector,
Symantec NetBackup, and Symantec Backup Exec, see the latest SPOCK document.

Table 1 (page 24) provides details of possible server combination scenarios for coexistence of
RMC-S and protect applications, such as HPE StoreOnce, HPE Data Protector, Symantec
NetBackup, or Symantec Backup Exec.

Table 1 Coexistence of RMC-S and Protect Applications

Server 2 configurationServer 1 configurationScenario
RMC-S + Protect
application

Symantec NetBackup Media Server
+ Symantec NetBackup Master
Server

RMC-S + Symantec NetBackup
Client

1RMC-S and Symantec
NetBackup

Not ApplicableRMC-S + Symantec NetBackup
Client + Symantec NetBackup

2

Master Server + Symantec
NetBackup Media Server

Symantec NetBackup Media ServerRMC-S + Symantec NetBackup
Client + Symantec NetBackup
Master Server

3

Symantec NetBackup Master ServerRMC-S + Symantec NetBackup
Client + Symantec NetBackup
Media Server

4

HPE Data Protector Cell ManagerRMC-S + HPEData Protector Client1RMC-S and HPE Data
Protector

Not applicableRMC-S + HPEData Protector Client
+ HPE Data Protector Cell Manager

2

Symantec Backup Exec Remote
Media Server

RMC-S + Symantec Backup Exec
Remote Agent for Windows +

1RMC-S and Symantec
Backup Exec

Symantec Backup Exec
Administration Console

Not ApplicableRMC-S + Symantec Backup Exec
Media Server + Symantec Backup
Exec Administration Console

2

NOTE: Make sure that your protect software and interface or production server are in Microsoft
Active directory. If the interface server is in one domain and protect software is in another directory,
then protect operation will fail.

RMC deployment
The RMCOVF template allows you to deploy and export virtual machines (VM), virtual appliances,
and vApps.
Deploying the OVF template, allows you to add preconfigured virtual machine to your VMware
vCenter Server or ESXi inventory.
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RMC OVF template can be deployed with the following:
• VMware vSphere Client 5.5 or later

• VMware vSphere Web Client 5.5 or later

NOTE: To deploy RMC OVF, you must have the vCenter Server license in your system.

Using VMware vSphere Client
To deploy the OVF template using VMware vSphere Client 5.5:
1. Connect to the vCenter using the vSphere client.
2. Select File→Deploy OVF template Figure 8 (page 25).

Figure 8 Deploying OVF template

3. Click Browse and select the .ovf file. Click Next to continue.
4. The OVF Template Details page appears. Read the details on the page and click Next.
5. Change the default name of the VM “Figure 9 (page 25)”, select an inventory location, and

click Next.

Figure 9 Name and location

6. Select a datastore “Figure 10 (page 25)“ on which you want to deploy and click Next.

Figure 10 Selecting a host
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7. Select a host or a cluster “Figure 11 (page 26)” and click Next.

Figure 11 Selecting a host or a cluster

8. Select a disk format “Figure 12 (page 26)”. The available formats are:
• Thick Provisioned Lazy Zeroed (default)—This creates a virtual disk in a default thick

format. A maximum space of 100 GB is allocated in this format.
• Thick Provision Eager Zeroed—This creates a virtual disk in a default thick format.

• Thin Provision—This method optimizes storage utilization by allocating storage space
in a flexible on-demand manner. A minimum space of 2 GB is allocated in this format.

Figure 12 Disk format

9. Select the available network to map the source to the target network “Figure 13 (page 27)”.
Click Next.
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Figure 13 Network mapping

10. On the Properties window Figure 14 (page 28), ensure the following details are listed:
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Figure 14 Properties window

DescriptionField name

The host name for the deployed RMC appliance.

NOTE: The host name can have amaximum of 24 characters consisting
of alphabets (A-Z), digits (0-9), and minus sign (-). Blank spaces are not
permitted as part of a name. No distinction is made between upper and
lower case. The first character must be an alpha character. The last
character must not be a minus sign. Underscore (_) is not a valid character.
If you do not specify a name with the correct naming convention then, by
default the RMC appliance assigns controller as the appliance name. HPE
recommends to change the Host name from Controller to a user defined
name, as per the specification mentioned.

Hostname

To set the current time for the appliance.

NOTE: The appliance time is taken from the ESXi host.

Timezone

The default gateway IP address.Default gateway

To configure the domain search list and to resolve the RMC host name.Search domain

DNS address of the servers.DNS servers

Select Static or DHCP from the list.

NOTE: If you select DHCP, the IP address is automatically assigned.

eth0: Bootprotocol

The IP address of the RMC appliance.eth0: ipaddress

The subnet mask of the RMC appliance.eth0: subnet mask

Select the appropriate value.eth1: settings

28 Configuring Protect Software



11. Enable the check box Power on after deployment.

Figure 15 Power on after deployment

12. Click Finish to install the RMC OVF template on vCenter server.
13. You can now access the RMC appliance.

NOTE: Configure the network interface–1 to work remote copy.

Using VMware vSphere Web Client
To deploy the OVF template using VMware vSphere Web Client 5.5 or later:
1. Launch the VMware vSphereWeb Client and right-click on the root node from the left panel.
2. From the Actions menu select Deploy OVF template.
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Figure 16 Deploying OVF template—Actions

The Deploy OVF template wizard appears.

NOTE: In the web client, a client plug-in is required to deploy RMC-S VSA. If the client
plug-in is not installed, VMware will not permit to deploy the RMC-S OVF.

3. Select a source location and click Next :

Figure 17 Source details

a. URL—Enter the URL from where you can download the OVF file.
b. Local file—Click Browse to navigate to the location on your local system or network

path to select the OVF file.
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4. In the Destination section:
• Select name and folder—Enter a name for the deployment template and select the

data center.

Figure 18 Name and folder

5. Click Next to proceed.
The Review details page appears displaying the RMC OVF template details.

Figure 19 Review details

6. Enter the description (if any) and click Next.
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7. Select Storage—Select a datastore to deploy the RMC appliance and click Next.

Figure 20 Select Storage

a. Setup networks—Select an available network to configure the RMC appliance and
click Next.

Figure 21 Select Network

b. Customize template—Enter the host name and network properties to configure the
RMC appliance. For more information, see VMware vSphere Client 5.5 — step 10.

IMPORTANT: It is mandatory to change the default host name (controller).
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Figure 22 Custom Template

c. Ensure all your network configuration are appropriate.

Figure 23 Network configuration

8. Check the displayed details and select Power on after deployment. Click Finish to deploy
the RMC OVF template.

Understanding the Registry
After RMC-S is successfully installed, information is written into the registry database in:
HKEY_LOCAL_MACHINE\SOFTWARE\HPE\RMC-S.

CAUTION: Do not edit the registry key value unless asked by your local service provider for
support purposes.
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Table 2 System Registry Values for RMC-S

ValueName

Interval in minutes between automatic synchronization of the
repository with HPE 3PAR. The default interval is 1440 minutes.

AnalyzeInterval

Protect process timeout value in minutes to confirm that NetBackup
has received the Protect request.

backupTimeout

Build number of the installed version of RMC-SBuild

Location of the XML repository.DataFilePath

HPE 3PAR RMC-S installation path.InstallPath

Tracing log files.LogFilePath

Specifies installed features of RMC-S.PackageType

Number of trace files to keep before deleting.TraceHistory

Trace level for the log file.TraceLevel

Information used to generate the trace file name.TraceLog

Size of the log files.TraceLogSize

Port used by RMC-S PortNo is set to 9932 by default.PortNo

Time interval in seconds to monitor the status of volume restore
operation.

PromoteTimeout

Current version of HPE Recovery Manager Central 2.0.2 for Microsoft
SQL.

Version

The maximum number of retries to find the restored disks after a
volume restore operation.

VolumeRestoreMaxRetry

NOTE:
• The DataFilePath field is created in the registry database only after you launch the RMC-S

GUI for the first time.
• An installation log file is created in the %Temp% folder for troubleshooting purposes.

Setting Up Symantec NetBackup
RMC-S supports full backups when running on a NetBackup master server. RMC-S also supports
user-defined backups when running on a NetBackup client machine.
To set up your Symantec NetBackup software, see the Symantec NetBackup documentation.
To configure Symantec NetBackup to function with RMC-S, set the following parameters during
the configuration process:

SettingBackup Policy Parameter

MS-WindowsPolicy type

Select themachine on which the RMC-S Interfaced Server
component is installed.

Clients

Add the client to Protect policy by entering NetBIOS name.

Ensure that this option is not selected.Collect disaster recovery information for Bare Metal
Restore
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SettingBackup Policy Parameter

Full backupType of backup

Activate all the time slots:Starting times for backups

• Modify Day: Mon

• Start Time: 12:00:00AM

• End Day: Sun

• End Time: 12:00:00AM

• Duration (days): 7

NOTE:
• If the interface server is running the NetBackup client interface, NetBackup cannot validate

the policy.
• If you add the NetBackup path to the system’s PATH environment variable after you install

HPE 3PAR StoreServ, you must restart the appliance for the changes to take effect.
• If RMC-S is running under the workgroup, then the client added in the Symantec NetBackup

Policy supports only host name. Fully Qualified Domain Name (FQDN) is not supported.

Configuring HPE Data Protector
Requirements

• HPE Data Protector Software

• Each data list name (also known as the backup specification) must be unique across the
entire system.

Setting Up the HPE Data Protector Backup Specification
To use HPE Data Protector with RMC-S, you must set up a default backup specification. The
backup specification specifies the default mount point and the necessary devices for tape backup.
1. Open the Data Protector GUI.
2. Select Devices & Media→Add Devices.
3. Enter the Device Name, Description, Device Type (File Library), Client, and click Next.
4. Click Next (do not select any items).
5. Select the Data Protector used for backups and perform the following tasks to configure the

Data Protector device:
a. Open Data Protector GUI and select Devices & Media→Add Devices.
b. Enter the Device Name, Description, Device Type (File Library), Client, and click Next.
c. Specify the location to save the backup and follow the onscreen instruction to complete

the configuration task.
6. Specify the directory list to save the backup.
7. Follow the onscreen instruction to complete the configuration task.
8. Select Backup→ Add Backup.
9. In the Create New Backup dialog box, select Blank_Filesystem_Backup and click OK.
10. Select the path to save the backup files and click Next.
11. Select the configured device created in the preceding steps and click Next.
12. Follow the onscreen instruction to backup the devices for tape.
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Setting Up HPE Data Protector Cell Manager Access

NOTE: HPE Data Protector Cell Manager 8.0 is not supported on Microsoft Windows x86
hosts.

To use HPE Data Protector with RMC-S, you must enable the system accounts on the registered
client system to access the Data Protector Cell Manager.
1. Open the Data Protector GUI.
2. In the tool bar menu, select Users.
3. Under the Users folder in the left pane, select admin→SYSTEM.
4. In the Client system menu on the General tab in the right pane, select <Any>.
For more information on installing HPE Data Protector, see HPE Data Protector documentation.

Configuring Backup Exec
Requirements

• Symantec Backup Exec Media server on RMC-S interface server.
Symantec Backup Exec software1.

2. Symantec Backup Exec Media server user name and password must be same as the
interface server, or you must add the current user to Backup Exec.

• Symantec Backup Exec Remote Media server
Symantec Backup Exec Remote media server must be installed on the same domain.1.

2. The interface server must be installed with Symantec Backup Exec Remote Agent for
Windows and Symantec Backup Exec administrator console. To do this:
a. Install media server on RMC-S production server.
b. Install remote agent from the production server to the interface server.
c. Install Symantec Backup Exec remote administrator console on the interface server.

3. From the Symantec Backup Execmedia server, Symantec Backup Remote administrator
console install path must be accessible with network path. For example, if Symantec
Backup Exec is installed on C:\Program Files\Symantec\Backup Exec then
\\hostname\c$\Program Files\Symantec\Backup Exec must be accessible.

4. To support Symantec Backup Exec Remote media server, RMC-Smust run with domain
administrator privileges. To run the RMC-S with domain administrator privileges:
a. To open the services, selectWindows→Control Panel→Administrative

Tools→Services.
b. Locate and double-click HPE RMC for Microsoft SQL.

Figure 24 HPE RMC for Microsoft SQL service

c. Select Log On tab.
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Figure 25 HPE RMC for Microsoft SQL

NOTE: For upgrade, the default installation path is C:\Program Files\3PAR\
RM\SQL\RMListeningAgent_s.exe.

d. Select This account. Enter the domain administrator username and password.

Figure 26 HPE RMC for Microsoft SQL

e. Click Apply and then select OK. You must restart the service when asked for.

NOTE: These changes must be done on all the servers wherever the RMC-S is
running.

• Symantec Backup Exec.

• Media server user name and password must be the same as the interface server, or you
must add the current user to Backup Exec.
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Setting up the Symantec Backup Exec

NOTE: To use Symantec Backup Exec with RMC-S, either remote administrator console or
typical setup (that is mediaserver, administrator console) must be installed on the interface server.
Device must be configured in Backup Exec for backup.

1. Open Symantec Backup Exec administrator console.
2. From the tool bar, select the device you want to backup.
3. To configure the device for backup, follow the onscreen instructions.

Using your protect software
• Youmust manually synchronize protect (backup). If a protect expires in your protect software,

you must manually remove protect from RMC-S.
• If you remove a valid protect from RMC-S, you must manually remove it from your protect

software.
• RMC-S does not track restore progress. You must use protect software to monitor restore

progress.
• For more information about using CLI commands with your protect software, see HpRmCli

Sql backup, HpRmCli Sql deletebackup, HpRmCli Sql listbackup, and HpRmCli
Sql restore in “Using RMC-S Command Line Interface” (page 68).

• For more information on protecting a snapshot, see “Protecting a snapshot” (page 52).

• For more information on restoring, see “Restoring” (page 57).

Using Symantec NetBackup
• Symantec NetBackup supports Master, Client, and Media modes for tape backups.

• Symantec NetBackup software is case-sensitive. If you are using NetBackup, make sure all
information entered pertaining to the policy is supplied with the proper case.

• When you are using NetBackup to back up to media or restore from media, monitor the
progress using the progress log:
<RM installation location>:\log\nbulog\database_timestamp.log

• To modify the timeout value for NetBackup software initialization, see “Understanding the
Registry” (page 33).

Using HPE Data Protector
For each HPE Data Protector backup you create, a postscript (.bat) file is created in the
$DP_HOME\bin folder (where $DP_HOME is the Data Protector install location; for example,
C:\program files\Omniback). This script cleans up after the associated backup is complete.

NOTE: RMC-S does not clean these postscripts. After a backup is complete (either successfully
or with failures), you can manually remove the associated postscript batch file if desired.

Using Symantec Backup Exec
Symantec Backup Exec supports media server and remote administrator console for backups.
When using the Backup Exec to backup/restore the media server, monitor the progress using
the administrator console.

38 Configuring Protect Software



NOTE: While performing concurrent backup operations:
• Backup of different databases with different policies is allowed while using Symantec

NetBackup.
• Backup of different databases is allowed, while using HPE Data Protector or Symantec

Backup Exec.
• Backups of different databases can be taken concurrently using Symantec NetBackup, HPE

Data Protector, or Symantec Backup Exec. For example, backup of database db1 using
Symantec NetBackup and database db2 using HPE Data Protector can execute
simultaneously.
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5 Working with RMC-S graphical user interface
The GUI features are a set of interactive tools that are grouped as:
• View— Enables you to control the information displayed about a resource so that you can

focus only on what you are interested in. The View menu is categorized into:

◦ Instance View—This view displays the databases under the instance, instance level
snapshot, and instance level protect.

◦ Database View—This view displays the databases under the instance, database level
snapshot, and database level protect.

NOTE: For information on the supported browsers, see SPOCK for HPE Storage products.

HPE Storage Systems
HPE Storage Systems enable you to create a point-in-time snapshot of data used for backups.
It is an effective way to back up live data or take a snapshot, and then resume live operations.
For more information on adding a storage system, see the HPE Recovery Manager Central User
Guide.

HPE Backup Systems
HPE Backup Systems enable you to back up snapshots created on HPE Storage System and
store it on HPE StoreOnce device. It also allows user to create a new store on the HPE StoreOnce
devices that can be used for backup purpose through RMC.
For more information on adding a backup system, see the HPE Recovery Manager Central User
Guide.

Registering a remote appliance
Registering the RMC appliance is a prerequisite for performing any Remote Copy operations.
You can register up to eight appliances and also register the same appliance as remote. The
appliance user credentials can be edited or the registered appliance can be unregistered.
For more information on adding a backup system, see the HPE Recovery Manager Central User
Guide.

HPE Interface Server
RMC-S Interface Server can be used with either HPEData Protector, HPE StoreOnce, Symantec
NetBackup, Symantec Backup Exec to back up and restore the snapshot created by RMC-S.
If you are using protect software in the backup environment, you must install a backup master
or a backup client or a backup media on the interface server.

Registering an interface server
To register an appliance:
1. Click HPE Recovery Manager Central→ Interface Server.
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2. Click +Interface Server or Register from the Actions menu.

NOTE: Action menu appears only after the interface server is added.

Figure 27 Registering an interface server

Enter the following details to add a new appliance:

DescriptionNameTitle

Enter the IP address or host name of the interface server.IP Address or Host
Name

General

The port used by the interface server to register.
The port number is set to 50001 by default. However, if you have
changed the port number during interface server registration, then
update the port number manually.

Port

The user name and password of the interface server.User Name
Password

The default application type is SQL.Application Type

This force registers the interface server.Force Register

NOTE: User with administrator privileges can register with the interface server onWindows
NT and can manage snapshots (RMCS operations, such as create, modify, delete) using
the RMC-S GUI. You can also use HpRmCli commands, connect to the interface server
using a different Windows NT account to manage all snapshots that are available in RMC-S.
Also, all Windows NT users with the administrator privileges can manage snapshots (RMC-S
operations, such as, create, modify, delete) created by other users and also by the user
registered in the interface server. For Remote Copy periodic, synchronous, or asynchronous
snapshots the target snapshots will always have the owner name as NT AUTHORITY\
SYSTEM.

Multi user support
You can use hprmcli command to connect to the interface server using the different Windows
NT account and to create snapshot. You can also create schedule hprmcli using Windows
scheduler or other tool with different Windows NT account. The snapshots are created with
different Windows NT user account that is not used during interface server registration in RMC-S.
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For example, User_1 can manage User_2 snapshots and perform all the operations.
For Remote Copy periodic/sync/async snapshots, target snapshots have their owner
name as NT AUTHORITY\SYSTEM not as legacy RMS where it appears as connected user
(configured through credential manager). Since the owner name is obsolete in RMC-S, this does
not fail any operation.

Unregistering an interface server
1. Select HPE Recovery Manager Central→ Interface Server.
2. Click Un-Register Un-Register from the Actions menu.
3. Click the check box Force Un-Register when the interface server has communication error

with RMC and you want to forcefully detach it from RMC.
4. Click Yes to unregister the server.

Editing an interface server
1. Select HPE Recovery Manager Central→ Interface Server.
2. Click Edit from the Actions menu.
3. Make the required changes and click OK.

Migrating an interface server
1. Select HPE Recovery Manager Central→ Interface Server.
2. Click Migrate from the Actions menu.
3. Click Yes, Migrate to migrate the interface server.

Registering a SQL server
For the RMC-S to manage SQL servers, the SQL Server instances must be registered. When
registering an SQL server instance in RMC-S, sysadmin role is required.
To configure the sysadmin role before registering the SQL server instance in the RMC-S GUI:
1. Connect to the SQL instance through the SQL Management Studio.
2. Select the Security option and click NT AUTHORITY\SYSTEM from Login option.
3. The Login properties - NT AUTHORITY\SYSTEM window appears.
4. Click Server Roles, select sysadmin role, and click OK.

NOTE: In Microsoft SQL Server, the system administrator’s role is not selected by default for
NT account (NT AUTHORITY\SYSTEM ), for 2014, 2012, 2008 R2, or 2008. For RMC-S to
operate, you must explicitly configure the system administrator’s role if it is not enabled.
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Registering a SQL instance
To add a new SQL instance:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. Click +SQL Instances or Register SQL Instance from the Actions menu to add an SQL

instance and enter the following details:

Figure 28 SQL server instances

NOTE: Action menu appears only after a SQL instance is added.

DescriptionNameTitle

The drop down lists all the registered interface servers.NameInterface Server

The instance dialog lists all the SQL instances that you want to add.Select InstancesSQL Server
Instances

This displays all the registered SQL instances that you want to delete.Change Selection

This allows you to add a new SQL server instance manually. The
syntax to add a host is //<appHostName>/<appInstanceName>
For example, //host1/instance1.

Add SQL ServerAdd SQL Server
Instances

This option is used when SQL Instance is added to Remote copy
configuration in the target RMC-S appliance.

Use for Remote
Copy

This force registers the interface server.Force RegisterForce Registration

3. Click OK to add the SQL instance.

Instance registration for Remote Copy
To register an instance:
1. Register the same SQL instance on primary and secondary using the optionUse for Remote

Copy.
2. In case of new database to be included for Remote Copy, you must rescan the instance in

the primary interface server as well on the remote interface server.
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3. You must be able to perform other standalone operations on primary interface server for the
same instance.

4. The following cases explain the instance registration for Remote Copy:

Case 1
• Modifying the existing registered standalone instance as remote copy Instance.

a. If an instance is not registered on the primary site, you must register the instance
using Force Register options. At the remote site, use Remote Copy to register the
SQL instance.

b. If an instance is registered (as managed/unmanaged) on the primary site, you again
must manually register the instance using Force Register options on the primary
site. At the remote site, use Remote Copy to register the SQL instance.

NOTE: Instance is not listed, you must manually add the instance as it is already
registered.

Case 2
• Modifying the existing Remote Copy instance as standalone instance. You must

unregister the instance on the primary site and on the secondary site and register
the instance manually on the required site with Force Register option.

Unregistering SQL server instances
To remove a server instance from the list of registered servers:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Un-Register MS SQL Server Instances.

Unregister MS SQL Server Instances page appears.
3. Click Unregister.

Figure 29 Unregister MS SQL server instances

4. Select an instance and click Remove.
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NOTE: In SQL server instance if snapshots or protect objects exist, then unregistering
puts the SQL server instance in an unmanaged state.

TIP: Use Remove+ to remove additional SQL server instance without closing the page.

5. Click OK to unregister the SQL instance.

Setting RMC-S policy
RMC-S applies policy settings at the instance level where each instance can have its own policy.
In addition, you can configure individual snapshot with their own policy settings.

How RMC-S policies work
The RMC-S policy-setting feature allows you to:

• Specify either a numeric-based or expiration-based policy for each instance and database
on a selected SQL server.

• Specify a retention time during which the instance or database and its snapshot cannot be
removed (if you have a Virtual Lock license).

NOTE: Modifications made to an existing policy are not retroactive. Snapshots created under
a previous policy (whether numeric or expiration-based) retain the policy setting under which
they were created.

Numeric-based policies
If you specify a numeric-based policy, you can modify the maximum number of snapshot and
Express Protect allowed per database and per instance. By default, all numeric based policy
permits you to create a maximum of 10 snapshot and 10 Express Protect per database and
instance.
To automatically remove the oldest snapshot for each database and instance, after the maximum
limit of snapshot is reached, enable the fields Remove the oldest Snapshot and Express
Protect before creating a new snapshot and Express Protect.

NOTE: A snapshot must be unmounted to be removed. If the oldest snapshot is mounted, a
new snapshot is not created until the oldest snapshot is unmounted.

Expiration-based policies
If you choose an expiration-based policy, you can set RMC-S to remove snapshot after a specified
period of time has elapsed.

Figure 30 Expiration-based policies
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If you specify an expiration time for a remote snapshot:

• If Remote Copy is set up in periodic mode, RMC-S sets the expiration time for the remote
snapshot on the Remote Copy interface server.

• If Remote Copy is set up in synchronous or asynchronous mode, RMC-S sets the expiration
time for both the snapshot on the primary server and the remote snapshot on the Remote
Copy interface server.

For more information, see the HPE 3PAR Remote Copy Software User’s Guide.
The expiration-based policy option is only available if HPE 3PAR StoreServ Storage System is
running HPE 3PAROperating System Software 3.1.1 MU3 or later and a valid Virtual Lock license
is available on HPE 3PAR StoreServ.

Retention Time Restrictions
If you have a Virtual Lock license, you can set a retention time for snapshot. The instance or the
database and the associated snapshot created within the retention period cannot be removed
during the retention period.
When setting a retention time:

• You must have a Virtual Lock license in HPE 3PAR StoreServ is set to retention time.

• The minimum retention time is 0 hour. The default maximum retention time is 43,800 hours
(1825 days).

• You can set a retention time for both numeric-based and expiration-based policies.

• The retention time cannot exceed the default maximum retention time set for the Storage
Server.

• The retention time cannot be longer than the expiration time (if the policy is expiration-based).

• If you create a remote snapshot and Remote Copy is set up in asynchronous periodic mode,
the retention time is applied to the remote copy on the Remote Copy interface server only.
If Remote Copy is set up in synchronous or asynchronous mode, the retention time is applied
to both the remote copy on the Remote Copy interface server and the snapshot on the
primary server.

• After the retention time is set, it can be increased, but it cannot be removed or reduced.

Setting RMC-S policies
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
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2. From the Actions menu select Policy Configuration.
The Policy Configuration dialog box appears.

Figure 31 Policy Configuration

Depending on whether you want to set a maximum number of copies or you want to set an
expiration time frame, do one of the following in the Policy Configuration dialog box:

Follow these steps:To set:

Policy Type 1. Select Numeric-based policy from the list box.
2. In the Maximum Instance level Snapshots and Maximum Database

level Snapshots text boxes, enter the desired maximum for each as a
number between 2 and 500.

3. To remove the oldest snapshot each time a copy above the maximum is
created, select the Remove the oldest Snapshots check box.
To keep the oldest snapshot (and therefore prevent new snapshot from
being made after the maximum number is reached), clear the Remove
the oldest Snapshots check box.

Policy Type 1. Select the Expiration-based policy from the list box.
2. In the Expiration Time text box, enter the number of hours or days after

which you want RMC-S to remove each snapshot. The maximum
expiration period is 43,800 hours (1825 days).

3. In the Default Retention Time, select either Hours or Days.

1. To modify the default retention time for the instance and its snapshots, enter the number of
hours or days you want to keep the instance and its contents.
Theminimum retention period is 0 hour. For more information about retention time restrictions,
see “How RMC-S policies work” (page 45).
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2. Click OK.
The Snapshots policy is effective immediately for all future snapshot.

NOTE: You can also use the RMC-SCLI command HpRmCli Sql policy to set RMC-S
policies. For more information, see “Using RMC-S Command Line Interface” (page 68).

Editing Numeric–based policy
When editing a Numeric–based policy for Snapshot, Protect, and Catalyst Copy the following
table lists an example of the behavior (when the numeric count is reduced).

Status
Reducing Numeric
Count to

Existing
numbers

Initial
Numeric–based
policy CountFeature

SupportedPNMSnapshot

Not supportedPNMProtect

Supported
(The next operation will
remove only one Catalyst
Copy).

PNMCatalyst Copy

where, P<N<=M.
For example, if the Initial Policy Count (M) is 10, the Existing number (N) is less or equal to 10,
and the reduced Numeric Count (P) is less than N.

Policy configuration for Catalyst Copy
Numeric–based policy can be applied for Catalyst Copy operation. Policy can be defined at
instance and database level. It is mandatory to create a Copy Policy before defining a
Numeric–based policy. Policy configuration can be achieved by associating Copy Policy along
with Copy Count and Remove Oldest.
You can add, modify, and remove Copy Policy association from Add Copy Policy Instance
Level and Add Copy Policy Database Level for instance and database respectively.

NOTE:
• Different Copy Policy can be associated at instance and database levels.

Modifying the Policy for a snapshot
To modify the retention time or the expiration time or both for a snapshot:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From theActionsmenu select Edit Snapshot. The Policy Configuration dialog box appears.
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Figure 32 Edit Snapshot

3. To set a new expiration time, select the Retention Time check box and enter a new value.
For more information on setting the retention and expiration time, see “How RMC-S policies
work” (page 45).

4. Click OK.

NOTE:
• You can also use the CLI command HpRmCli Sql policy to modify RMC-S policies. For

more information, see “Using RMC-S Command Line Interface” (page 68).
• Setting the same expiration value and retention value for a snapshot using Time Constraints

must be done at the same time.

Creating snapshot
You can use RMC-S to manually create snapshot at the instance and the database level. You
can also schedule snapshot to automatically make snapshot of instances or databases or both.

NOTE: You can configure RMC-S to automatically send email notifications when snapshot are
manually or automatically created. For more information, see “Configuring Email Notifications”
(page 64).

How snapshot creation works
When RMC-S creates a snapshot for an instance, it creates a snapshot of all databases under
that instance, including the instance's system databases. Similarly, when RMC-S creates a
snapshot for a database, it creates a snapshot of the entire volume where the database and log
files reside.
If you have Remote Copy set up, you can also create a snapshot to be saved on the Remote
Copy interface server; this type of copy is called a remote snapshot.

NOTE:
• For more information about setting up instances, databases, and volumes to avoid data loss,

see “Configuring the SQL Database” (page 15).
• RMC-S creates copy-only backup for availability databases on secondary replica.

Manually creating a snapshot
1. Change the view to database view and select database for snapshot, similarly change the

GUI view to instance view and then select the instance for instance level snapshot.
2. Click HPE Recovery Manager Central→ Microsoft SQL Server.
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3. From the Actions menu select Create Snapshot. The Create Snapshot Databases Level
dialog box appears.

Figure 33 Edit Snapshot

4. Optional: To adjust policy values for this snapshot (or, if you are scheduling automatic copies,
this group of snapshot):
• To adjust the retention time, select Retention Time and enter the new retention time.

Valid values are 0 {h|H|d|D} (for no retention time) to retention time is 43,800 hours
(1825 days).

• To adjust the expiration time, select Expiration Time and enter the new expiration time.
For Availability Group databases, the policy settings for the selected server or instance are
displayed. If the policy settings does not exist for the selected server or instance, the default
settings are displayed.

NOTE: User needs to set value 0 {h|H|d|D}, if you do not want to set the expiration value
and retention value for the snapshot to be created. If this is not set, the global expiration
policy value and retention policy value will be used for the snapshot when expiration-based
policy is configured.

5. To retain the newly created Remote Copy after backup, ensure that the Remove Snapshot
check box is not selected.

6. In the Target Interface Server IP / Host name field, enter the name of the Remote Copy
interface server.

7. Select the Schedule Now check box for the server instance. In the parameters area, enter
the required information:
• Schedule Name—The name of the schedule within the policy you are using.

• Schedule Description—This provides the descriptions for the schedule that is used
during the snapshot creation.

• Frequency—This describes the frequency with which the automatic snapshots are to
be created. Select the appropriate box from the list.
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• Start Time—Use the slider to set the hour and minutes at which you want RMC-S to
start creating automatic snapshots.

• Day—Select the hour at which you want RMC-S to start creating automatic snapshots.
8. To immediately create a snapshot, click OK in the Create Snapshot dialog box.

NOTE: For Microsoft SQL Server 2012 and 2014 Availability Group configuration:
• You can not create snapshot on all the replica sites at once. You can create snapshot

on the replica sites only one at a time.
• You can not create snapshot of the secondary replica databases which are not set for

read mode. They will not be displayed in the RM GUI. They will also not be a part of
instance level snapshot. However, you can create snapshot from the primary site by
selecting the secondary replica site from RMC-S GUI or RMC-S CLI.

Mounting a snapshot
You can use RMC-S to mount a snapshot at the instance or database level.

NOTE: When a snapshot of a SQL server instance or database needs to be mounted to a
target server which is neither production server nor interface server, ensure that the RMC
appliance associated with the target server is same as that of the interface server. If it is not the
same, use the rmcregistratiotool.exe to modify the appliance registry entries in the target
server. For more details on how to modify RMC registration tool. Register the RMC appliance IP
and credential on the target server. The new RMC appliance will be used by target server for
various operations.

1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Mount Snapshot.
3. In the Mount Point Only text box, enter the path or mount point where the snapshot has to

be mounted.

NOTE:
• RMC-S does not support mounting a snapshot to a drive letter or to a path involving a

cluster shared drive letter.

4. Optional when mounting a snapshot at a Database level. Check Attach Database option
to attach a Database.

NOTE:
• Attach is not supported in the Instance level.

• By default, when the Attach Database check box option is selected and the default
database name appears as <Database Name>_<Timestamp>.

• If a database name is not entered then attach database will not be performed.

• Snapshot of databases part of the Availability Group will be attached to its own instance,
but the new database will not be a part of the Availability Group.

• Mount point on a shared folder or on reparse points, such as SYMLINK, NFS mount,
and CSV, are not supported.
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5. Click Mount Now.
RMC-S:
• Adds the mounted snapshot to the list view in the Activity pane.

• Displays the server to which the copy is mounted in the Mounted Host column.

• Displays the absolute path on which the copy is mounted in the Mount Point column.

NOTE: If the snapshot is already mounted, no action is performed if the user tries to
mount it again.

Unmounting a snapshot
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Unmount Snapshot.
3. RMC-S displays a dialog box asking you to confirm the unmount. Click Yes, Unmount.

RMC-S:
• Removes the mounted snapshot from the list view in the Activity pane.

• Displays Not Mounted in the Mounted Host column.

• Detaches the database and closes all the connections to the database.

Protecting a snapshot
You can use RMC-S to back up snapshot to media using HPE Data Protector, HPE StoreOnce,
Symantec NetBackup, or Symantec Backup Exec.
To back up a snapshot to media, you must first configure your protect software (HPE Data
Protector, HPE StoreOnce, NetBackup, or Backup Exec) as described in “Configuring Protect
Software” (page 24).
You can create a backup of an instance or a database on the instance or the database level and
at the snapshot level.

• When you create a backup on either the instance or the database level, RMC-S creates a
new snapshot, and your protect software backs it up.

NOTE: If the windows user performing the backup operation at the instance or the database
level does not have mount privilege due to absence of administrative privilege, the backup
creation fails.

• When you create a backup at the timestamp level, RMC-S mounts the existing snapshot,
and your protect software backs it up using the same timestamp.

NOTE: If the windows user performing the backup operation at the timestamp level on an
unmounted snapshot does not have mount privilege due to absence of administrative
privileges, the backup creation fails.

You can also schedule RMC-S to automatically create backups of instances or databases or
both.
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NOTE:
• You can execute concurrent backup jobs through RMC-S GUI and multiple

RMC-S CLI instances.

• You can configure RMC-S to automatically send email notifications when backups are
manually or automatically created.

• You can execute concurrent backup jobs through RMC-S GUI and multiple RMC-S CLI
instances.

Manually creating protect at the instance or the database level
When you create a backup of a snapshot for an instance or a database, RMC-S automatically
creates a snapshot and mounts it on your protect software and backs up the snapshot to media
server, and RMC-S unmounts the snapshot. By default, RMC-S deletes the created snapshot
when the backup is complete. You can also choose to have RMC-S retain the newly created
snapshot.
To create a backup of a snapshot at the instance or the database level:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Protect.

The Express Protect dialog box appears.
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Figure 34 Express Protect

3. The following fields are required to backup your snapshot:

DescriptionField name

This displays the destination appliance HPE StoreOnce and Media to back up your snapshot.
The default protect appliance is HPE StoreOnce.

Protect
Destination

The name of the SQL server.MS SQL Server

The name of the SQL server instance, where the snapshot is taken.MS SQL Server
Instance

The name of the MS SQL Server database.MS SQL Server
Database

Express Protect Configuration

This automatically creates a snapshot if no snapshot is available for protect.Snapshot Name

54 Working with RMC-S graphical user interface



DescriptionField name

Express Protect Target

Enter the backup name that needs to reside on the target server.Express Protect
Name

Select the backup policy from the drop-down that needs to be applied.Backup Policy

Enable the check box if it is an incremental backup.

NOTE: Make sure a full or incremental backup is completed successfully before enabling
the incremental check box.

Incremental

The snapshot will be retained even after the snapshot is taken.Retain
Snapshot after
Protect

Schedule

Schedules enable you to schedule data volume snapshots and backups. Check the text box
and enter the details.

Schedule Now

The name of the snapshot is scheduled.Schedule Name

The description of the snapshot.Schedule
Description

Select the schedule frequency. The options are:Frequency

• Weekly—Snapshot is performed at the specified time and day of the week.

• Daily—Snapshot is performed at the specified time.

• Hourly—Snapshot is performed at the specific hour.

• Monthly—Snapshot is performed at the specified time and day of the month.

• Yearly—Snapshot is performed once a year at the specified time, day, and month.

• One Off—A onetime snapshot is performed.

Set the time for the scheduled snapshot to start.Start Time

Set the day for the scheduled snapshot to start.Day

4. (If you use a protect software) Change the Protect Destination to Media and enter the
following details

1. From the Select Vendor list, select the protect software you are using:
• Symantec NetBackup

• HPE Data Protector

• Symantec Backup Exec
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2. In the Verify Protect Parameters area, enter the required information, depending on your
protect software:

Enter these parameters:
If you are
using:

• Data List: The name of the data list.

For more information about data lists, see the description of backup specifications in HPE
Data Protector documentation.

HPE Data
Protector

Symantec
NetBackup

• Policy Name: The name of the policy you are using.

• Schedule Name: The name of the schedule within the policy you are using.

• Master Server Name: The NBU master server.

For more information, see Symantec NetBackup documentation and “Configuring Protect
Software” (page 24).

Symantec
Backup Exec

• Media Server : Backup Exec media server name

• Device Name: Backup Exec device name configured for Backup

The name of the Backup Policy.HPEStoreOnce

3. To retain the newly created snapshot after protect, ensure that the Retain Snapshot after
Protect check box is not selected.

NOTE: RMC-S, by default, removes the snapshot it creates during the backup.

4. To immediately create one protect, click OK.
• RMC-S creates the protect, names it as its timestamp if:

◦ You are using an expiration-based policy, or

◦ You are using a numeric-based policy but either have not reached the maximum
number of snapshot allowed or the policy is configured to remove old copies as
necessary (that is, the Remove the oldest snapshots check box is selected).

• RMC-S does not create the backup if you are using a numeric-based policy and:

◦ The policy is not configured to remove the oldest snapshot (that is, the Remove
the oldest snapshots check box is not selected), and

◦ You have reached the maximum number of snapshots allowed, and therefore
RMC-S cannot create a new snapshot.

Editing a snapshot
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Edit Snapshot.

The Edit Snapshot Databases Level dialog box appears.
3. You can only increase the retention time of the snapshot.

NOTE: The retention time cannot be removed or reduced after it is set and the volume
cannot be removed until the retention time expires.

Removing a snapshot
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
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2. From the Actions menu, select Remove Snapshot.
The Remove Snapshot dialog box appears.

3. Click Yes, Delete to delete the snapshot.

Analyzing and Synchronizing the Repository
You can use RMC-S to compare and synchronize snapshot in the RMC-S repository with the
HPE 3PAR StoreServ Storage System.

NOTE: If changes are there in the HPE 3PAR StoreServ with respect to properties, such as
name, size, associated with virtual volumes that are part of the RMC-S instance or database
recovery set, performAnalyzewith the synchronize repository on that particular SQL server from
RMC-S.

1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Analyze.

The Analyze dialog box appears.
To analyze the repository without synchronizing it, clear Synchronize Results with
Repository.

3. Click Yes.
The success message appears and the completed task can be tracked through the Activity
page.

Restoring
You can use either the volume restore feature or the file copy feature of RMC-S to restore an
instance or a database from a snapshot, or you can perform a media restore from a backup.

NOTE:
• If the servers are configured in a shared volume environment, such as a Microsoft cluster

environment, see Configuring RMC-S in a Cluster environment.
• You can use CLI commands to promote the snapshot to its parent base volume. For more

information, see the HPE 3PAR Command Line Interface Administrator’s Manual.
• Any type of restore operation on the secondary node in Availability Group is not supported.

• Any type of restore operation from target interface server is not supported for periodic,
synchronous, or asynchronous snapshot.

TIP: Volume restore is the fastest method.

Restoring an Instance or a Database with Volume Restore

WARNING! DO NOT perform a volume restore if the base volume to which you are promoting
the snapshot contains files for other instances or databases.
The volume restore feature promotes the snapshot to the base volume and overwrites all data
on the volume. If you perform a volume restore on a volume that hosts files for multiple instances
or databases, the operation deletes all data not contained in the promoted snapshot.

NOTE: An SQL data restore failure can occur when an SQL server service is explicitly stopped
outside of RMC-S Software for Microsoft SQL and the disk path itself is not available for the
system in a standalone setup.
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1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Restore.

The Restore dialog box appears.

Figure 35 Volume Restore

3. Enter the following information:

DescriptionNameTitle

Select volume from the drop-down
box.

Restore TypeRestore Type

Select the option from the drop down
box:

Restore OperationGeneral

• Restore from Snapshot

• Restore Express Protect to parent
volume

• Restore Express Protect to
another volume

The name of the snapshot to be
restored.

Snapshot Name

Displays the name of the MS SQL
Server.

MS SQL Server

The name of the instance where the
snapshot is restored.

MS SQL Server Instance

The name of the database where the
snapshot is restored.

MS SQL Server Database
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4. Click Restore.
The snapshot completely overwrites the instance or the database. The instance or the
database is now restored.

NOTE: If the secondary replica node in theMicrosoft SQL Server 2012 and 2014 Availability
Group configuration becomes inaccessible during the restore process, then the user must
manually join the databases back to the Availability Group.

Restoring an Instance or a Database with File Copy Restore
The file copy restore feature enables you to restore a specific instance or a database from a
snapshot. Unlike the volume restore feature, the file copy restore feature does not overwrite the
entire volume.
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Restore.

The Restore dialog box appears.
3. Enter the following information:

DescriptionNameTitle

Select file copy from the drop-down
box.

File CopyRestore Type

General

Select to clone the database.Clone DatabaseDatabase Restore Option

Enter the name of the database to
which you want the snapshot
restored.

Database Name

If you want to restore the clone
database to a location other than its

Alternate Path

parent location, enter the directory
path to the alternate database.

To use the point-of-failure recovery
method to restore the database.

No Recovery

The system creates a point-in-time
snapshot, uses it to create the

Point-in-time

protect, and then removes this after
the snapshot is complete.

To use the auto-restore feature for
restoring a database to the point of
failure.

Point of Failure
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4. Click Restore.
Depending on whether you restored the snapshot to its parent location or created a clone
database, RMC-S does one of the following:

• If you restored the snapshot to its parent location, RMC-S completely overwrites the
instance or database with the snapshot. The instance or database is now restored.

• If you restored the snapshot with an alternate database name but you did not specify
an alternate database path, RMC-S copies the snapshot to the specified clone database
name (at the parent location) and attaches the database.

• If you restored the snapshot with an alternate database name with an alternate database
path, RMC-S copies the snapshot to the specified clone database name at the alternate
location and attaches the database.

NOTE: If the secondary replica node in theMicrosoft SQL Server 2012 and 2014 Availability
Group configuration becomes inaccessible during the restore process, then the user must
manually join the databases back to the Availability Group.

Restoring an Instance or a Database from Media
You can restore backups to their original location (that is, to the instance or the database location
of the snapshot that was used to create the backup, not to the original SQL database or instance
location), or you can specify an alternate location.
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Restore.

The Restore dialog box appears.
3. Enter the following information:

DescriptionNameTitle

Select media from the drop down
box.

MediaRestore Type

General

The time stamp details of the
snapshot you want to restore.

Snapshot TimestampMedia Restore Option

The methods used by vendors to
restore a snapshot.

Vendor Restore Method

If you want to restore the clone
database to a location other than its

Alternate Path

parent location, enter the directory
path to the alternate database.

4. Click Restore.
The protect software mounts the backup to the specified location as a snapshot. To complete
restoring of an instance or a database, move the snapshot to the volume or the database.

Rescan
If configuration of registered instance is modified (for example, a new database is created under
that instance), the instance must be rescanned to update the registration.
To rescan an instance:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
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2. From the Actions menu select Rescan.
The Rescan Server Configuration dialog box appears.

Figure 36 Rescan

3. Click Yes, Rescan to rescan the instance.
If Availability Group databases are configured on Microsoft SQL Server 2014, rescan is
recommended in the following instances:
• There is a change in Availability Group configuration.

• An SQL Server is migrated to SQL 2014 from its previous versions.

NOTE: When a database is removed from the Availability Group, selecting Rescan removes
Availability Group information from the database information list.

Rescan All
To rescan an instance:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Rescan All.

The Rescan All Server Configuration dialog box appears.

Figure 37 Rescan All

3. Click OK to rescan all the instances at the same time.
If Availability Group databases are configured on Microsoft SQL Server 2014, rescan is
recommended in the following instances:
• There is a change in Availability Group configuration.

• An SQL Server is migrated to SQL 2014 from its previous versions.

NOTE: When you perform Rescan All on all SQL instances from the interface server, SQL
instance with same names are repeated. You must select the appropriate instance of the interface
server to perform SQL operations.
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Catalyst Copy
Catalyst Copy enables you to copy Express Protect backup(s) from the source backup system
(HPE StoreOnce appliance) to the target backup system (HPE StoreOnce appliance). Catalyst
Copy helps you to replicate backup at remote site that can be restored in case of disaster scenario.

Creating a Catalyst Copy
1. Click HPE Recovery Manager Central→ Microsoft SQL Server→ .
2. Select Create Catalyst Copy menu and enter the following details:

NOTE: Action menu appears only after a Catalyst Copy is created.

Figure 38 Catalyst Copy–Existing

DescriptionNameTitle

The name of the Catalyst Copy.NameGeneral

The description for the created Catalyst Copy.Description

Displays the name of the SQL server.MS SQL Server

Displays the name of the SQL instance.MS SQL Server
Instance

Displays the name of the SQL database.MS SQL Server
Database

Displays the names of all the backup policies that was created
for Protect.

Copy Policy

If a backup is created. By default, it is Existing.Express Protect

This lists all the available backups.Express ProtectExpress Protect

3. Click Add to create a new Catalyst Copy from the existing Express Protect.
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4. If an Express Protect is not available or need to be created, then perform the following steps:

Figure 39 Creating Catalyst Copy–New

DescriptionNameTitle

The name of the Catalyst Copy.NameGeneral

The description for the created Catalyst Copy.Description

Displays the name of the SQL server.MS SQL Server

Displays the name of the SQL instance.MS SQL Server
Instance

Displays the name of the SQL database.MS SQL Server
Database

Displays the names of all the policies that was created for Express
Protect.

Copy Policy

For creating a new Express Protect.Express Protect

The name of new Express Protect.NameExpress Protect

This displays the name of the backup policy created.Backup Policy

The backup is backed up incrementally.Incremental
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DescriptionNameTitle

This retains the snapshot after backup is taken.Retain Snapshot after
Protect

Scheduler will create New Snapshot, New Express Protect, and
New Catalyst Copy.

NOTE:
• You cannot create a schedule of Catalyst Copy from one

source to multiple targets at the same time.

• If the new option is selected to create Snapshot, Express
Protect, Catalyst Copy, then you must provide Scheduler
details for the operation.

Schedule

5. Click Add to create a Snapshot, Express Protect, and Catalyst Copy.

NOTE:
• Make sure a full backup is completed successfully before enabling the Incremental

check box.
• A second snapshot of the same recovery set must be created successfully for incremental

comparison.

TIP: Use Add+ to create additional backup without closing the page.

Removing Catalyst Copy
This helps to remove an express protect at the database or instance level.
1. Select a database or instance and select Remove Protect from the Action menu.
2. RMC-S displays a dialog box asking you to confirm. Click OK.

Configuring Email Notifications
You can configure RMC–S to automatically send an email when:

• You create a snapshot or remote snapshot, or RMC-S automatically creates a snapshot or
remote snapshot according to the task schedule.

• You create a protect or RMC-S automatically creates a protect according to the task schedule.

• You restore a volume, an instance, or a database.
In addition, you can configure the email to notify you only when an operation completes, or only
when an error message displays, or when either occurs.
To configure email notifications:
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. From the Actions menu select Email Configuration.

The Email Configuration dialog box appears.
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Figure 40 Email Configuration

3. Enter the following information:

DescriptionNameTitle

By Default, the Email Type is SMTP.Email TypeEmail Configuration

Name of the email server.SMTP Host Name

Port of the email server.Port

Email address of the sender.Sender Email
Address

Password for the sender’s email address.Password

To send email notifications via the Secure Sockets
Layer protocol, select the check box.

SSL

Email address of the person to be notified of task
activity or errors or both.

Receiver Email
Address

Create snapshotOperations • Info—RMC-S sends informational emails for
successful operations.

Protect
• Error—RMC-S sends informational emails for

operations that were not completed successfully.Restore
Both informational and error emails contain the result
of the operation and the related CLI output.

NOTE: Unselect the check box to stop the email
notification.

4. Click OK.
RMC-S encrypts the password and saves the configuration as an XML file with the filename
servername_instancename_EmailConfig.xml. Each time a snapshot or backup is
created or a restoration is performed on this instance, RMC-S checks the XML file and, if
email is configured for the task, sends an email with the task information or error messages
or both.
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NOTE:
• Ensure that the Port of SMTP server is not already in use or not blocked by antivirus.

• If SMTP server is not enabled for authentication, then any password is accepted.

Support Ticket
If you have troubleshooting issues, you would be asked to generate a support ticket by HPE
support. This ticket provides a log of everything that has happened on the RMC appliance,
interface server, and SQL production servers.
The RMC appliance ticket option in GUI is a mandatory selection. However, selecting interface
server and SQL production server can be customized based on user need.

NOTE: Make sure that the browser security settings permit files to be transferred from the
RMC appliance to the host machine.

Generating a support ticket
To create a new support ticket:
1. Click HPE Recovery Manager Central→ Settings.
2. Select RMC-S and click on the interface server from the drop down.
3. Click SQL Servers to select the registered SQL servers. To change the selection, click

Change Selection option.
4. Click Yes, Generate to generate a support ticket.

The success message Support ticket is being generated appears.

Figure 41 Support Ticket
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NOTE: If the generated support ticket is not displayed on the RMC GUI, then it indicates
that the ticket is being created.

5. After the ticket is generated, the ID appears on the RMC GUI and tracks the progress of the
support ticket generation status through Activity monitor.

6. After completion, the ticket_id appears and the Download Support Ticket is enabled.

Figure 42 Support Ticket format

Ticket format description

• 20141031—The first part of the ticket displays the year, month, date (yyyymmdd).

• Z162932—The second part of the ticket displays the ticket identification number.

Downloading a support ticket

Click the todownload thesupport ticket.

Deleting a support ticket

Click the to delete the support ticket.

Support ticket contents
• Extract the ticket to a file.

• ticket_id\logs\var\uploads\RMCS for RMC-S related log files.

• ticket_id\logs\var\log for viewing for RMC appliance related log files.
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6 Using RMC-S Command Line Interface
Use the RMC-S Command Line Interface (CLI) to manage RMC-S functionality using commands.
To use the CLI, first log on to RMC-S with a valid username and password.

Logging in to the CLI
Before you can enter CLI commands, you must first log on to the appliance with a valid username
(admin) and password (admin123).

HPE RMC-S CLI
The following table lists the CLI commands that you can use in RMC-S.

Use this CLI command:To do the following:

HpRmCli Sql rescanScan the SQL server for any changes

HpRmCli Sql createCreate Virtual Copies

HpRmCli Sql displayDisplay Virtual Copies currently in the repository

HpRmCli Sql mountMount Virtual Copies

HpRmCli Sql removeRemove unmounted Virtual Copies

HpRmCli Sql unmountUnmount Virtual Copies

HpRmCli Sql policySet Recovery Manager policies

HpRmCli Sql setvcSet policy for specified virtual copy

HpRmCli Sql backupBackup Virtual Copies to media using Symantec
NetBackup, HPE Data Protector, Symantec Backup Exec
or HPE StoreOnce

HpRmCli Sql listbackupList backup entries currently in the backup pool

HpRmCli Sql restoreRestore from Virtual Copies

HpRmCli Sql deletebackupDelete backup entries currently in the backup pool

HpRmCli Sql timeconfigChange the wait time for backup, volume restore, and
analysis

HpRmCli Sql analyzeAnalyze and synchronize the volumes in the HPE 3PAR
StoreServ Storage System and the Virtual Copies in the
repository

HpRmCli Sql repositoryQuery and change repository location

HpRmCli Sql portconfigQuery and change the port location

HpRmCli Sql reportGather the environmental statistics and create a log file
for diagnosis
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NOTE:
• The previous syntax for Recovery Manager commands is supported for backward

compatibility. The previous syntax is as follows:
RmSql <Command_name> [Command_options] <arguments>

• Only NetBIOS names must be used while specifying values for any server type, such as
production server, interface server, mount server, target server, media server, or master
server.
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RMC-S Commands
This section describes the CLI commands in detail.

HpRmCli Sql analyze

NOTE: If there are changes in the HPE 3PAR StoreServ with respect to properties, such as
name, size associated with virtual volumes that are part of the RMC-S instance or database
recovery set, performAnalyzewith the synchronize repository on that particular SQL server from
RMC-S.

SYNTAX
HpRmCli Sql analyze -s <SQL server> [-sync] [-f]

DESCRIPTION
The HpRmCli Sql analyze command validates all virtual copy records by matching Virtual
Copies in the HPE 3PAR StoreServ Storage System against the records in the RMC-S repository.
If any existing Virtual Copies in the system are missing from the repository and vice versa. RMC-S
displays them as out-of-sync records.

PARAMETERS
The following options are supported:
-s <SQL Server> The SQL server to which the database belongs.
-sync Optional. Remove out-of-sync Virtual Copies from the repository. If not

specified, out-of-sync Virtual Copies remain in the repository.
-f Optional. Forcefully remove out-of-sync records from the repository. You

must use this option in conjunction with the -sync option. If not specified,
the system prompts you to confirm the removal of out-of-sync Virtual
Copies.

NOTE: When you use the -f option, Recovery Manager automatically removes out-of-sync
records without prompting for confirmation.

EXAMPLES
The following example validates all Virtual Copies under the specified SQL server.
HpRmCli Sql analyze -s <SQLserver>
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HpRmCli Sql backup

SYNTAX
HpRmCli sql backup -s <SQL Server> [-i <SQL instance>] [-d <database>][-t <timestamp> | -r ]
[-so]-ts <Target Server>][[-p <policyName> -u <scheduleName> -M <masterServer>]|[-pn <StoreOnce backup Policy
Name>]|[-dl <datalistName>]|[-be -mediaserver <mediaservername> -device <devicename>]][-noemail] [-backupname]

DESCRIPTION
The HpRmCli Sql backup command backs up a virtual copy to the specified media. The
backup can be an existing virtual copy, or it can be a new virtual copy created by this command.

PARAMETERS
The following options are supported:
-s <SQL Server> SQL server name to which the database belongs.
-i <SQL instance> SQL server instance to which the database belongs.

Optional: Defaults to MSSQLSERVER if not specified.

-d <database> Optional: The database to which snapshot belongs.
-t <timestamp> The timestamp of snapshot to backup.

Optional: Without -t <timestamp> specified, a point-in-time
snapshot will be created for backup purpose, and then removed
after backup completion.

-r <retain> Optional: Retain the snapshot created if <-t> is not specified.
Optional: This option is applicable only when -t <timestamp>
to backup is not specified.

-ts Target Server name to which the backup will be created.
Optional: Defaults to the local host.

-p <policyName> NBU Policy name.
-u <scheduleName> NBU backup schedule name.
-M <masterServer> NBU master server name.

Optional: NBU parameters optional if datalist specified.

-dl <DataList> Data Protector datalist name.
Optional: datalist optional if NBU parameters specified.

-noemail Optional: Suppresses email notification.
-mediaserver
<mediaservername>

Backup Exec media Server.

-device <devicename> Backup Exec device.
-be Use Backup Exec to backup.
-so Use StoreOnce to backup.
-backupname Optional: StoreOnce backup Name (Snapshot timestamp will be

used if backupname is not provided).
-pn <StoreOncepolicy> The backup policy name in Recovery Manager for Central.
-in Use Incremental backup to StoreOnce.
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EXAMPLE
The following command performs a backup of snapshot 020405162103 on the server inst1
with SQL instance "instance 1" whose data is currently mounted to drives i:\ and j:\.
For NetBackup: HpRmCli sql backup -s inst1 -i "instance 1" -d test_db

-t 020405162103 -p test -u full -M host1

For HPE DataProtector: HpRmCli sql backup -s inst1 -i "instance 1"
-d test_db -t 020405162103 -dl datalist1

For Backup Exec: HpRmCli sql backup -be -s inst1 -i "instance 1"
-d test_db-mediaserver test -device testDevice
HpRmCli sql backup -be -s inst1 -i "instance 1"
-d test_db-t 020405162103 -mediaserver test -device
testDevice.

For HPE StoreOnce: HpRmCli sql backup -so -s inst1 -i "instance 1"
-d test_db -backupname "backupname" -pn
"policyname"HpRmCli sql backup -so -s inst1 -i
"instance 1" -d test_db -t 020405162103 -pn
"policyname"HpRmCli sql backup -so -s inst1 -i
"instance 1" -d test_db -in -pn "policyname".

HpRmCli Sql create

SYNTAX
HpRmCli Sql create -s <SQL server> [-i <SQL instance>] [-d <database>]
[-noemail][-exp <time>{h|H|d|D}] [-retain <time>{h|H|d|D}] [-f] [-rc <target server> ][-tss <system id>]

DESCRIPTION
The HpRmCli Sql create command creates a virtual copy of a SQL database or databases
under an instance on the primary host where the SQL server instance is running. (The virtual
copy can be mounted to a host later for off-host processing.)
The HpRmCli Sql create command used with –rc parameter synchronizes the volumes in
periodic Remote Copy group where a single SQL database or all of the SQL databases under
an instance reside and creates Virtual Copies at the secondary site as a backup.
As with HP 3PAR Recovery Manager for Microsoft SQL Server itself, this command only supports
the online backup of an entire SQL database. Therefore, you must make sure the database is
online before creating a virtual copy.

PARAMETERS
The following options are supported:
-s <SQL server> SQL server to which the database belongs.
-i <SQL instance> Optional. SQL server instance to which the database belongs. If

not specified, MSSQLSERVER is used as the default.
-d <database> Optional. The database from which to create a virtual copy. If not

specified, the instance level of the virtual copy is used as the
default.

-rc <target server> Optional. For the Remote Copy Service, an HPE Recovery
Manager Central for SQL server located at the secondary site with
HPE Recovery Manager Central SQL installed must be provided.

-noemail Optional. Do not send an email notification even if configured for
this operation. If not specified, Recovery Manager sends an email
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notification of the virtual copy creation if configured. For more
information, see Configuring Email Notifications.

-exp <time>{h|H|d|D} Optional. Set the expiration time for this virtual copy to the specified
time and time unit. Valid values are:
• To set the expiration time in hours: 336h (or H)

• To set the expiration time in days: 14d (or D)

• To remove the expiration period: 0h (or 0H) or 0d (or 0D)
To use this option, the RMC-S policy must be set to an
expiration-based policy.
If not specified, RMC-S creates the virtual copy using the expiration
time specified in the current policy.

NOTE: During remote virtual copy creation for periodic mode,
the expiration time set at the secondary interface server is used
as the time based policy. The policy set at the primary interface
server is ignored. In case of synchronous mode, the expiration
value is applied to both, the local virtual copy, and remote virtual
copy. Remote virtual copy creation cannot be done if primary
interface server and secondary interface server for different values
are set for expiration at synchronous mode.

-retain
<time>{h|H|d|D}

Optional. Set or extend the retention time for the specified virtual
copy to the specified time. The virtual copy cannot be removed
during this time period.

NOTE: Retention time restrictions are:
• You must have a Virtual Lock license to use the retain

option.
• The minimum retention period is 1 hour.

• The default retention time is 336 hours (14 days).

• The retention time cannot exceed the value of the StoreServ's
VVRetentionTimeMax.

• You can set a retention time regardless of whether the policy
is numeric or expiration-based.

• The retention time cannot be longer than the expiration time
(if the policy is expiration-based).

• During remote virtual copy creation for periodic modes, the
retention time set at the secondary interface server is used
as the time based policy. The policy set at the primary
interface server is ignored. In case of synchronous mode, the
retention value is applied to both, the local virtual copy and
remote virtual copy. Remote virtual copy creation cannot be
done if different values are set for retention at primary interface
server and secondary interface server for synchronous mode.

• The retention time cannot be removed or reduced after it is
set.

• To set no retention time for this virtual copy, use a value of
0h (or 0H) or 0d (or 0D).
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-f Optional. When used with the -retain option, does not request
confirmation for the retention time modification.

-tss system id Optional. For the Remote Copy Service, Target Storage System
Id configured at the secondary site in RMC. This is required if
target interface server is managing both StoreServ systems in
case of Synchronous Long distance (SLD).

EXAMPLES
The following command creates a virtual copy for the database test on the SQL server
(SQLServer).
HpRmCli Sql create -s SQLServer -d test

The following command creates a virtual copy for the database test on a virtual SQL server
(SQLVirtualServer) on a cluster.
HpRmCli Sql create -s SQLVirtualServer -d test

The following command creates a Remote Copy snapshot for the database test on a virtual SQL
server (SQLVirtualServer) on a cluster to a secondary site server (SecondaryServer).
HpRmCli Sql create -s SQLVirtualServer -d test -rc SecondaryServer

NOTE: Use quotes ("") when an option value includes spaces.

NOTE: RMC VSS waits up to 10 seconds for a snapshot operation and this interval can not
be configured. In most of the cases, 10 seconds is a sufficient interval to successfully create a
virtual copy. However, in some circumstances under heavy loads, 10 seconds may not be enough
time, and the virtual copy might fail on this attempt. This failure is a RMC VSS framework
requirement on Microsoft’s part.
If such a failure occurs, RMC VSS does not automatically retry the shadow copy creation. You
must use the RMC-S GUI or CLI to reattempt to create the virtual copy.
During virtual copy creation, the system creates a backup document in XML format. This document
contains current system information and can be used for restore purposes.

NOTE:
• The snapshot volume set is limited to 64 volumes. In other words, each database (under

database-level operation) or each instance (under instance-level operation) can spread over
a maximum of 64 volumes.

• You can only perform database- or instance-level operations if you have system admin
permissions for SQL Server.
RMC-S creates copy-only backup for availability databases on secondary replica.
You can execute concurrent snapshot creation jobs through multiple RMC-S CLI instances.
In this case, RMC-S queues the requests to the RMC VSS so that all the requests are
serviced without any failure.

HpRmCli Sql deletebackup

SYNTAX
HpRmCli Sql deletebackup -s <SQL server> [-i <SQL instance>] [-d <database>] -t <timestamp> [-so]
[-id <StoreOnce backup id>]
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DESCRIPTION
The HpRmCli Sql deletebackup command removes the specified backup entry from the
Recovery Manager repository only. It does not remove the Symantec NetBackup or HPE Data
Protector entry, nor does it remove the actual images backed up by the backup process.

PARAMETERS
The following options are supported:
-s <SQL server> SQL server to which the backup belongs.
-i <SQL instance> Optional. The SQL instance associated with the database. If not

specified, MSSQLSERVER (local) is used as the default value.
-d <database> Optional. The database-level backup to be removed. If not specified,

the instance-level backup is removed by default.
-t <timestamp> The backup entry timestamp.
-id <BackupId> Optional: The backup ID of HP StoreOnce.
-so <StoreOnce> Optional: This is used for HP StoreOnce backup.

EXAMPLE
The following command deletes the backup timestamp 020405162103:
HpRmCli Sql deletebackup -s server1 -d db1 -t 020405162103

HpRmCli sql deletebackup -s server1 -d db1 -t 020405162103 -so -id
15478-l5478-95li6-7894561
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HpRmCli Sql display

SYNTAX
HpRmCli Sql display -s <SQL server> [-rc <target server>] [-i <SQL instance>] [-d <database>]
[-t <timestamp>]

DESCRIPTION
The HpRmCli Sql display command displays all Virtual Copies in the server at a local site
or a remote site.

PARAMETERS
The following options are supported:
-s <SQL server> SQL server associated with the database.
-i <SQL instance> Optional. The SQL instance associated with the database. If not

specified, MSSQLSERVER is used as the default value.
-d <database> Optional. Display the Virtual Copies created for a given database.

If not specified, all database and instance Virtual Copies belonging
to the SQL server are displayed by default.

-rc <target server> Optional. The Remote Copy target server at secondary site. To
use this option, the RMC-S Interface Component server, with
RMC-S installed, must be located at the secondary site. If not
specified, the local site is used as the default value. Availability
Group information is not displayed for Virtual Copies at a remote
site.

-t <timestamp> Optional. Display detailed information about a specific virtual copy
in the local repository. If no virtual copy is specified, Recovery
Manager displays information about all Virtual Copies. For
availability database virtual copy with the timestamp, the availability
group information is not displayed when this option is specified. If
this option is not specified, availability group information is
displayed for all the availability database Virtual Copies listed by
the command.

NOTE: RMC-S does not support using the command HpRmCli Sql display -t for display
of information about a virtual copy that exists at a secondary site.

The following command displays the Virtual Copies for server1.
HpRmCli Sql display -s server1

NOTE: Use quotes ("") when an option value includes spaces.

NOTE: If you create an instance level virtual copy and then issue the HpRmCli Sql display
command, the Database column displays all to indicate that Recovery Manager has created
Virtual Copies of all databases except the Temp database.
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HpRmCli Sql listbackup

SYNTAX
HpRmCli Sql listbackup -s <SQL server> [-i <SQL instance>] [-d <database>] [-t <timestamp>]

DESCRIPTION
The HpRmCli Sql listbackup command displays all Virtual Copies being backed up via
Symantec NetBackup or HPE Data Protector.

PARAMETERS
The following options are supported:
-s <SQL server> SQL server to which the database belongs.
-i <SQL instance> Optional. SQL server instance to which the database belongs. If not

specified, MSSQLSERVER (local) is used as the default.
-d <database> Optional. Database for which to display Virtual Copies. If not specified,

RMC-S displays Virtual Copies being backed up at the instance and
the database level.

-t <timestamp> Optional. The timestamp of a specific virtual copy to display. If not
specified, Recovery Manager displays all Virtual Copies being backed
up.

NOTE: When you specify a timestamp, RMC-S displays detailed information about the virtual
copy being backed up.
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HpRmCli Sql mount
Verify that the following conditions are complete before performing the mount operation:
• The SQL server must be in healthy state for attach operation.

• The disk residing on the database must be online and visible.

• The original database must be online for the attach operation to succeed.

• The name of target server and the SQL server must be same for attach operation to succeed.

• The secondary database files (.mdf), as a part of original database, are also available in the
attached database.

• If the SQL instance is running in a clustered environment, the snapshots of databases taken
from a particular SQL instance cannot be attached to the SQL instance running on the cluster
environment.

NOTE:
• You cannot attach a data onto a cluster SQL instance because the data is on a separate

disk.
• When a snapshot of a SQL server instance or database needs to be mounted to a target

server which is neither production server nor interface server, ensure that the RMC appliance
associated with the target server is same as that of the interface server. If it is not the same,
use the rmcregistratiotool.exe to modify the appliance registry entries in the target
server. For more details on how to modify RMC registration tool. Post the RMC appliance
IP and credential in the target server. The new RMC appliance will be used by target server
for various operations.

SYNTAX
HpRmCli Sql mount -s <SQL server> -t <timestamp> [-m <mount point>] [-ts <host name>]
[-a <attachDatabaseName> -i <instanceName> -d <OriginalDatabaseName> ]

DESCRIPTION
The HpRmCli Sql mount command mounts a virtual copy created by the HpRmCli Sql
create command.
To mount a virtual copy, you must create an available mount point on the NTFS volume before
you execute the command.
If necessary, use -a option to attach a database to the SQL server.

PARAMETERS
The following options are supported:
-s <SQL server> The SQL server associated with the database.
-i <SQL instance> Optional. SQL server instance belonging to the specified database. If

not specified, MSSQLSERVER (local) is used as the default and valid
only if –a option is specified.

-d <database> Optional. Original Database to be attached. Valid only if –a option is
specified.

-t <timestamp> The timestamp for the virtual copy to be mounted.
-m <mount point> Optional. The mount point for virtual copy devices. If not specified,

%SystemDrive%\3parSnapshot is used as the default mount point.
-ts <hostname> Optional. The name of the host on which to mount the virtual copy. If

not specified, the local host is used as the default mount point.
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-a <attach
database>

Optional. New name of the database to be attached.

WARNING! If you mount a volume with the HpRmCli Sql mount command, you must
unmount the volume with the HpRmCli Sql unmount command. Do not manually unmount a
volume that was mounted with the HpRmCli Sql mount command.

NOTE: When mounting in read-write mode, the system uses VDS API to make the volume
read and write enabled. However, if there is another operation on the disk and the device is
locked, you cannot unmount the volume. If you attempt to unmount a locked volume, the system
displays the following error message:
ERROR: COM call “pVolumeMF->Dismount(TRUE,FALSE)” failed.
Returned HRESULT = 0x80042413
Error text: <Unknown error code>
Error: There was an expected HRESULT error catched: 0x80042413 <Unknown
error code>

This error message indicates the same issue as VDS_E_DEVICE_IN_USE.
To resolve the issue, restart the VDS service or reboot the machine.

NOTE: RMC-S only supports snapshot exposure to a host.
RMC-S does not support mounting a virtual copy to a drive letter or to a path involving a cluster
shared drive letter.
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HpRmCli Sql policy

SYNTAX
HPRMCLI Sql policy -s <SQL Server> [-i <SQL instance>][-d <SQL database>] [-q][-exp <time>{h|H|d|D}]
[-in <instance snapshot limit>] [-n <database snapshot limit>][-r] [-retain <time>{h|H|d|D}]
[-f] [-ts <target server>][-inb <instance storeonce backup limit>][-nb <database storeonce backup limit>]
[-rb <retain oldest backup>][-bp<database backup policy>][-ipb<instance backup policy>]
[-inc <instance catalyst copy limit>][-nc <database catalyst copy limit>]
[-rc <retain database catalyst copy list>][-irc <retain instance catalyst copy list>]
[-cp <database catalyst copy policy>][-icp <instance catalyst copy policy>][-resetRS <reset recoveryset>]

DESCRIPTION
The HpRmCli Sql policy command sets the RMC-S policy at the instance and the database
level.

PARAMETERS
The following options are supported:
-s <SQL server> SQL server to which database belongs.
-i <SQL instance> SQL instance to which database belongs.

Optional: Defaults to MSSQLSERVER if not
specified.

-q Optional: Queries current policy status.
-in <number> Optional: Number of instance snapshots to

retain.
-n <number> Optional: Number of database snapshots to

retain.
-r Optional: Retain the oldest snapshot when

number of snapshots exceed its limit. Default
is set to retain.

-inb <number> Optional: Number of instance StoreOnce
backups to retain

-nb <number> Optional: Number of database StoreOnce
backups to retain.

-rb Optional: Retain the oldest StoreOnce backup
when number reaches the limit.

-bp Optional: Id of the backup policy for
StoreOnce backup of database.

-ibp Optional: Id of the backup policy for
StoreOnce backup of instance.

-inc number list Optional: List of maximum number of instance
level StoreOnce Catalyst Copies.

-nc number list Optional: List of maximum number of
database level StoreOnce Catalyst Copies.

-rc bool list Optional: List of boolean values for deleting
oldest copy when database level StoreOnce
Catalyst Copy count exceeds limit.

-irc bool list Optional: List of boolean values for deleting
oldest copy when instance level StoreOnce
Catalyst Copy count exceeds limit.

-cp string Optional: Id of Catalyst Copy policy for
database.
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-icp string Optional: Id of Catalyst copy policy for
instance.

-exp <time>{h|H|d|D} Optional: Specifies the expiration time for the
Snapshot.
<time> is a positive integer value and is in
the range 1-43,800 hours (1825 days).

-retain <time>{h|H|d|D} Optional: Specifies the amount of time from
the current time that the Snapshot will be
retained.
<time> is a positive integer within the range
of 0-43,800 hours (1825 days).

NOTE: 0{h|H|d|D} implies no application
of retention.

-f force Optional - Suppresses retention time
confirmation.

-ts target server Optional: The destination server whose policy
values will be displayed.

-resetRS Optional: Reset associated recoveryset
details.

-d SQL database Optional: SQL database.

NOTE: No new snapshot will be created with combination of number of snapshot exceeding
the limitation and -r option specified.
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EXAMPLE
The following command will change the policy of server1 to 12:
HPRMCLI Sql policy -s server1 -n 12

The following command will set the expiration and retention time on an instance "instance 1":
HPRMCLI Sql policy -s server1 -i "instance 1" -exp 12h -retain 5h

NOTE: Use quotes ("") for arguments that include spaces.

HpRmCli Sql portconfig

SYNTAX
Hprmcli Sql portconfig [-s WindowsHost][-r SQL/WebPort][-n number]

DESCRIPTION
After RMC-S is installed, the default port used for communication between the interface server
and production server is 9932. If necessary, you can specify an alternate port.

PARAMETERS
The following options are supported:
-s <WindowsHost> Optional: Specifies a RM Windows Host to list or configure the port

settings. Defaults to localhost if unspecified.
-r <SQL/webPort> Optional: If specified then the command will update the SQL/web port.

If not specified, then the command will show the current configuration.
-n <number> Optional: If specified then the command will update the port used. If

not specified, then the command will show the current configuration.
Accepted port range for SQL port is from 1024—65535. (Default SQL
service port: 9932).
Accepted port range for web port is from 50001—52000. (Default web
service port: 50001).

EXAMPLES
The following command will query the port number that is using now:
Hprmcli Sql portconfig

The following command will change the local SQL port to 9999:
Hprmcli Sql portconfig -r SQLPort -n 9999

The following command will change the local web port to 51111:
Hprmcli Sql portconfig -r WebPort -n 51111

The following command will change the server SQLserver port to 9999:
Hprmcli Sql portconfig -s SQLserver -r SQLPort -n 9999

The following command will change the server SQLserver port to 51111:
Hprmcli Sql portconfig -s SQLserver -r WebPort -n 51111
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HpRmCli Sql remove

SYNTAX
HpRmCli Sql remove -s <SQL server> -t <timestamp>

DESCRIPTION
The HpRmCli Sql remove command removes a virtual copy from the system and the RMC-S
repository. The virtual copy must not be mounted; if the virtual copy is mounted, RMC-S does
not remove it.

PARAMETERS
The following options are supported:
-s <SQL server> The SQL server to which the database belongs.
-t <timstamp> The timestamp of the virtual copy to remove.

NOTE: After a virtual copy is removed, it cannot be used to restore data from the RMC-S
repository. However, you can restore a removed virtual copy from the backup media if the virtual
copy was backed up with the HpRmCli Sql backup command and the backup entry is still
available.

HpRmCli Sql report

SYNTAX
HpRmCli Sql report -s <WindowsHost> -output <OutputDirectory>

DESCRIPTION
The HpRmCli Sql report command collects the environmental information from a specified
Windows host and creates a report for diagnostic purposes.

PARAMETERS
The following options are supported:
-output <OutputFolder> Full path to the folder in which to generate the report.
-s <WindowsHost> Name of the RMC-S host.

EXAMPLE
The following command retrieves platform information from the host Grampus and saves the
report in c:\MyReport.
HpRmCli Sql report -s Grampus -output c:\MyReport
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HpRmCli Sql repository

SYNTAX
HpRmCli Sql repository [-a <alter destination>] [-r]

DESCRIPTION
After RMC-S is installed, by default the repository directory is located under the RMC-S install
directory. To provide the highest level access to the repository, you can change the repository
destination to the location of the HP 3PAR virtual volume.

PARAMETERS
The following options are supported:
-a <alter Destination> Optional: Move the repository to an alternate location. If not

specified, RMC-S retains the current repository location.

NOTE: If you use the CLI to move the repository to an
alternate location, you must restart the RMC-S GUI to view
the repository in its new location.

-r Optional. Retain the current repository location and only make
changes to the registry values. Use this option when RMC-S
is reinstalled after operating under an alternate location. If you
use this option, you cannot move the repository path back to
the alternate location.

EXAMPLE
The following command moves the repository directory to d:\3parvv and updates the registry
database as well.
HpRmCli Sql repository –a d:\3parvv

HpRmCli Sql rescan

SYNTAX
HpRmCli Sql rescan -s <SQL server> [-i <instance>]

DESCRIPTION
The command rescans the SQL server instance.

PARAMETERS
The following options are supported:
-s Server SQL server The SQL server to which the database belongs.
-i instance name (default is
MSSQLSERVER

The SQL server instance to which the database belongs.
If not specified, MSSQLSERVER is used as the default.

EXAMPLE
The following rescans the SQLserverA with default instance
HpRmCli Sql rescan -s SQLserverA.

EXAMPLE
The following rescans the SQLserverA with instanceB
HpRmCli Sql rescan -s SQLserverA -i instanceB.
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NOTE: In SQL 2014, by default, sysadmin role is not selected for NT account. For RMC-S to
work, user has to explicitly configure the sysadmin role.

HpRmCli Sql restore

SYNTAX
HpRmCli Sql restore -s <SQL Server> [-i <instance>] [-d <database>] <-t timestamp> [-ts <target server>]
[[-M <masterServer>]| [-dp]|[-be]][-clonedb <database name>] [-a <altLocation>] [-norecovery] |[-so]
[-volume <volume names>][-pointoffailure][-sn <storagesystem serialnumber>] [-id <StoreOnce backup ID> [-snap]
[-f] [-noemail]

NOTE: When performing -pointoffailure option, always use the latest version of a virtual
copy to complete the restoration successfully.
Any type of restore operation on the secondary node in Availability Group is not supported.

DESCRIPTION
You can use the HpRmCli Sql restore command to perform three different types of restore:

• Media Restore—Using an existing backup entry, RMC-S Server issues a restore request
to the protect software in use (HPE StoreOnce, Symantec NetBackup, HPE Data Protector,
or Symantec Backup Exec). The image associated with this backup entry is then restored
to the location you specify. If you do not specify an alternate location, data is restored to
<SystemDrive:>:\3parSnapshot by default.

• File Copy Restore—Using an existing virtual copy, RMC-S Server mounts the copy, extracts
the database files, and copies the files back to their original locations. Because the files are
copied over one by one, File Copy Restore is a relatively slow but reliable way of restoring
data.

• Volume Restore—Using an existing virtual copy, RMC-S Server removes the existing
VLUNs, promotes the virtual copy back to its base volume, and recreates the VLUNs back
to the host. Volume Restore is relatively fast. However, you should not perform this restore
if the base volumes you are promoting contain data from other instances or databases.

PARAMETERS
The following options are supported:
-s <SQL server> The SQL server to which the database belongs.
-i <SQL instance> The SQL server instance to which the database belongs.

If not specified, MSSQLSERVER is used as the default.
-d database(s) The database of database level snapshot or multiple

databases of an instance level snapshot.
Optional: Defaults to instance level restore.

-t <timestamp> The timestamp of snapshot to restore.
-ts <target server> Target Server to perform restore (NBU Media Restore

only).
Optional: Defaults to local host.

-clonedb db name Optional: Restores the database to a different database
name.

-a altLocation Optional: Alternate restore location.
-snap Optional: Performs volume promote restore.
-norecovery Optional: Restores database with the SQL NORECOVERY.
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-pointoffailure Optional: Restores database with SQL NORECOVERY flag
and applies the transaction log on the database.

-M <masterServer> NBU master server name.
Optional: Defaults to restore from snapshot.

-dp Use Data Protector restore method.
Optional: Defaults to restore from snapshot.

-noemail Optional: Suppresses email notification.
-f Optional: Suppresses confirmation for SQL Service stop.
-be Use Backup Exec restore method.
–so Use StoreOnce restore method.
–id StoreOnce backup id.
–sn Storage system serial number.
–volume Volume names.

NOTE:
• If you are restoring a volume that is part of a Remote Copy target system, you must restore

the virtual copy to the Remote Copy volume group that is part of the same Remote Copy
target system as the virtual copy.

• Use listbackup command to find StoreOnce backup ID.

• Restore from HPE StoreOnce Protect to volume can leave your SQL disk in write protect
mode. For more information on how to clear the disk write protection on Windows Server,
see KB article1008115.

• After restore from HPE StoreOnce Protect to volume, the Windows OS may ask you to scan
and fix the volume for the disk. HPE recommends to cancel the Scan and Fix dialog box
and continue with your operation.

EXAMPLES
The following command performs a media restore using Data Protector:
HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -dp

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -dp
-a J:\Test

The following command performs a media restore using NBU:
HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -M
server1

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -M
server1 -a J:\\Test

The following command performs a media restore using Backup Exec:
HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -be

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -be
-a J:\Test

The following command performs an Express Protect Restore using StoreOnce:
Restoring to parental volume: HpRmCli Sql restore -s server1 -i inst -d testdb
-t 020405162103 -so -id 87t45612-7894r2123 -snap

Restoring to any volume: HpRmCli Sql restore -s server1 -i inst -d testdb -t
020405162103 -so -id 87t45612-7894r2123 -sn 7456121 -volume vol1,vol2
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The following command performs a Filecopy Restore (instance level, database level):
HpRmCli Sql restore -s server1 -i inst -t 020405162103

HpRmCli Sql restore -s server1 -i inst -t 020405162103 -d
"testdb1,testdb2,testdb3"

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103
-norecovery

HpRmCli Sql restore -s server1 -i inst -t 020405162103 -d testdb
-pointoffailure

The following command performs a Volume Restore:
HpRmCli Sql restore -s server1 -i inst -t 020405162103 -snap

HpRmCli Sql restore -s server1 -i inst -d testdb -t 020405162103 -snap

NOTE:
• Use quotes ("") when an option value includes spaces.

• Restart the SQL server service from SQL Server Configuration Manager after the snapshot
volume restore operation for an SQL instance or database completes.
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HpRmCli Sql setvc

SYNTAX
HpRmCli Sql setvc -s <SQL server> [-i <instance>] [-d <database>] -t <timestamp> -exp <time>{h|H|d|D}
[-retain <time>{h|H|d|D} [-f]]

DESCRIPTION
The HpRmCli Sql setvc command sets time constraints for an existing virtual copy. To use
this command, the policy must be an expiration-based policy.

PARAMETERS
The following options are supported:
-s <SQL Server> The SQL server to which the existing virtual copy belongs.
-i <SQL instance> Optional. The SQL server instance to which the existing virtual

copy belongs. If not specified, MSSQLSERVER is used as the
default.

-d <database> Optional. The database of the existing virtual copy. If not
specified, the timestamp is assumed to be at the instance level.

-t <timestamp> The timestamp of the virtual copy for which you are changing
the expiration time.

-exp <time>{h|H|d|D} Optional. Set the expiration time for this virtual copy to the
specified time and time unit. Valid values are:
• To set the expiration time in hours: 336h (or H)

• To set the expiration time in days: 14d (or D)

-retain
<time>{h|H|d|D}

Optional. Set or extend the retention time for the specified virtual
copy to the specified time. The virtual copy cannot be removed
during this time period.

-f Optional. When used with the -retain option, does not request
confirmation for the retention time modification.

NOTE: Retention and expiration time restrictions are:
• The minimum retention period is 1 hour; maximum retention time is 43,800 hours (1825

days).
• The default retention time is 336 hours (14 days).

• The retention time cannot exceed the value of the StoreServ's VVRetentionTimeMax.

• You can set a retention time regardless of whether the policy is numeric-based or
expiration-based.

• The retention time cannot be longer than the expiration time (if the policy is expiration-based).

• If you create a remote virtual copy and Remote Copy is set up in asynchronous periodic
mode, the retention time is applied to the remote copy on the Remote Copy interface server
only. If Remote Copy is set up in synchronous mode, the retention time is applied to both
the remote copy on the Remote Copy interface server and the virtual copy on the Remote
Copy primary server.

• The retention time cannot be removed or reduced after it is set.

• Setting the same expiration value and retention value for a virtual copy using setvc command
must be done at the same time.
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EXAMPLE
The following command sets the expiration time for virtual copy 020409162103 to 2 hours:
HpRmCli Sql setvc -s server1 –t 020409162103 -exp 2h

The following command sets the expiration time for virtual copy 020409162103 to 30 days:
HpRmCli Sql setvc -s server1 –t 020409162103 -exp 30d

NOTE: Use quotes ("") when an option value includes spaces.
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HpRmCli Sql timeconfig

SYNTAX
HpRmCli Sql timeconfig [-s <WindowsHost>] [-prt <promotetime>][-bkt <backuptime>][-ai <analyzeinterval>]

DESCRIPTION
After you install RMC-S, by default, the wait time for snap volume restore is 30 seconds, the wait
time for backup is 5 minutes, and the wait time for analysis of the repository with the HP 3PAR
StoreServ Storage System is 60 minutes. You can use this command to change these values.
If no parameters are specified, it queries the time value for each setting.

PARAMETERS
-prt <promotetime> Optional. The time in seconds to wait for volume promotion. If not

specified, 30 seconds is used as the default wait time.
-bkt <backuptime> Optional. The time in minutes to wait for backup. If not specified,

5 minutes is used as the default wait time.
-s <WindowsHost> Optional. The Windows host on which RMC-S is installed. If not

specified, the local host is used as the default.
-ai <analyzeinterval> Optional. The time in minutes to wait for automatically analysis of

the repository against the system. Valid values are 10-1440 (10
minutes to 24 hours). If not specified, 60 minutes is used as the
default.

NOTE: If you use the -ai command to modify the analyze interval, you must restart RMC-S
for the change to take effect.

EXAMPLES
The following command queries the time value for each setting:
HpRmCli Sql timeconfig

The following command changes the promote time to 50 seconds:
HpRmCli Sql timeconfig -prt 50

The following command changes the backup time to 7 minutes:
HpRmCli Sql timeconfig -bkt 7

The following command will change the analyze interval to 30 minutes:
HpRmCli Sql timeconfig -ai 30

NOTE: In most cases, there is no need to change these values unless the backup and/or
volume restore are taking an unusually long time to complete.
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HpRmCli Sql unmount
Verify that the following tasks are complete before performing the unmount operation:
• The SQL server must be in healthy state for attach operation.

• The disk residing on the database must be online and visible.
The following results of the unmount operation may occur:
• Unmounting of a virtual copy does not occur if unmounting operation is unsuccessful.

• Detach operation proceeds automatically following the unmount operation.

NOTE: There is not a separate command for attaching and detaching operations. Both
commands automatically follow after a mounting and unmounting operation.

SYNTAX
HpRmCli Sql unmount -s <SQL server> -t <timestamp> [-f <forceDetach>]

DESCRIPTION
The HpRmCli Sql unmount command unmounts a currently mounted virtual copy that was
mounted by the HpRmCli Sql mount command. RMC-S can only unmount a virtual copy if its
mounted status is not “Available.”

PARAMETERS
The following options are supported:
-s <SQL server> The SQL server to which the database belongs.
-t <timestamp> The timestamp of the virtual copy to unmount.
-f <forceDetach> Optional: Forces detach when there are active connections on database.

NOTE: During an unmount operation, RMC-S detaches any attaching databases, removes
the mount point from the mounted volumes, and then removes the mount point folder.
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7 Recovery for Microsoft SQL Server
Microsoft SQL Server Recovery Models

Microsoft SQL Server offers three disaster-recovery models:

• Simple Recovery Model—The Simple Recovery model enables you to restore a database
to the point at which a snapshot or backup was created; it does not enable you to restore a
database at a specific point in time. Therefore, any data modifications made between the
time of the most recent backup and the time of the failure are lost. This recovery model uses
circular logging to minimize the amount of space used for transaction logs.

• Full Recovery Model—The Full Recovery model enables you to restore a database at a
specific point in time; either to a snapshot created before the error occurred or to the point
just before which a system failure occurred. Under this recovery model, transaction logs are
saved until a failure occurs, and therefore no data is lost.

• Bulk-Logged Recovery Model—The Bulk-Logged Recovery model is used for
high-performance operations, such as bulk copying and bulk data modification.

NOTE:
• RMC-S supports only Full Recovery Model.

• If you are recovering data from SQL servers across Microsoft Active directory, make sure
that you have stored the login and password for each directory on your interface server. For
more information, see “Configuring RMC-S policies” (page 16).

Recovering Data with RMC-S
RMC-S supports both recovery from snapshot and recovery frommedia. However, only recovery
from snapshot enables you to perform a point-in-time or point-of-failure recovery.
If you are running SQL Server under the Full Recovery model, you must perform a restore from
a snapshot.
You can use manual method or auto-restore method to restore the data. To use the auto-restore
method, refer to “Recovering Data with Auto-Restore” (page 94).

Preparing for the Recovery Process
Before recovery begins, you must ensure the database can be taken offline.
1. Check whether database ID 9 is full.

When the SQL server takes a database offline, it writes a checkpoint record to database ID
9. After this log file becomes full, the SQL server cannot write the checkpoint record and
therefore cannot take the database offline.

2. If database ID 9 is full, perform one of the following:
• Back up the transaction log for the database.

• Detach the database.

NOTE: Restoring a database or an instance on a file stream drive is not supported.

RMC-S uses the VSS framework to restore data. For the VSS framework takes a database offline
before it is restored. You must place the database in single-user mode.

Recovering from Logical Errors with Point-in-Time Recovery
Point-in-time recovery is useful for recovering from logical errors. For example, if you accidentally
altered an entry or deleted a table, you can use a snapshot to restore your instance or database
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back to a consistent, known prior state. Point-in-time recovery restores the instance or database
to the state it was in at the time the snapshot was created.

Recovering All Data with Point-of-Failure Recovery
Point-of-failure recovery is useful if you cannot afford to lose any data in the event of a system
failure. Recovering consists of the following tasks:
• Determining Whether You Can Perform a Point-of-Failure Recovery

• Performing a Point-of-Failure Recovery

NOTE: Point-of-failure recovery only supports a file copy restore at the database level.

Determining Whether You Can Perform a Point-of-Failure Recovery
In point-of-failure recovery, a database is completely recovered up to the point of the failure. You
can perform a point-of-failure recovery if all of the following conditions are met:

• You have performed a full backup of the SQL database.

• You have subsequently used the SQL backup utility to perform one or more transaction log
backups.

• You have access to undamaged transaction log backups and active transaction logs (that
is, even if one or more transaction log backups are damaged, undamaged copies of these
backups exist).

NOTE: A transaction log backup is a copy of all the log records written to the live transaction
log after the last full database backup or the last transaction log backup. If any transaction log
backups within the sequence are missing, the database can only be restored to the last
consecutive backup that exists in the sequence, and you cannot perform a full recovery.

For more information on how to roll a database forward using a transaction log, see:
http://msdn.microsoft.com/en-us/library/ms189596.aspx

Performing a Point-of-Failure Recovery
When you apply the protect transaction log to a database that has been restored using a snapshot,
the system uses the STOPAT option to roll forward the database to a specific point in time.
To roll forward the transaction log, you can use either SQL Server Management Studio or a
command line tool such as OSQL. For example,

To perform a point-of-failure recovery:
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1. Locate the most recent consistent full backup and determine the following information:
• Timestamp (For example, 010106000000)

• Server name (For example, SQLserver01)

• SQL instance name (For example, SQLInstan01)

• Database name (For example, northwind)
2. At the command prompt, enter the following:

HpRmCli.exe Sql restore -s server name -i SQL instance name -d
database name -t timestamp -norecovery

For example,
HpRmCli.exe Sql restore -s SQLserver01 -i SQLInstan01 -d northwind
-t 010106000000 -norecovery

3. To apply the transaction logs and to recover the database to the point in time desired, enter
the following restore commands at the command prompt:
a. Enter the following command for the first to the penultimate backed-up transaction logs

in the sequence:
RESTORE log database name from transaction log backup media with
norecovery;

The database is still in “no recovery” mode. You can now apply the backed-up transaction
logs to update the database to the point of failure.

b. Enter the following command for the last backed-up transaction log:
RESTORE log database name from transaction log backup media with
recovery; -stopat “timestamp"

For example,
RESTORE log northwind from Disk='G:\log1.bak' with norecovery;

RESTORE log northwind from Disk='G:\log2.bak' with norecovery;

RESTORE log northwind from Disk='G:\log3.bak' with recovery;
-stopat "Jun 28, 2006 5:44 PM"

Recovering Data with Auto-Restore
You can use the auto-restore feature to restore a database from a snapshot to a point of failure
at database level and to restore multiple databases of a given instance level snapshot.
A database can be restored by using either a File Copy or Volume copy.

NOTE: If you have named your database log files to a non-default name, do not use a selective
database restore with the nondefault database from an instance level snapshot. For example, if
your database name is rmsdb.mdf, the log file name must be rmsdb_log.ldf, and not any other
name. In some cases when the log file name is not a default name, use the file copy restore at
a database level or file copy restore of the complete instance level snapshot.
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Performing a File Copy Restore

Prerequisites

• Ensure that there is at least one snapshot of the database available or create one before
performing the restore operation.

• Ensure to always select the latest snapshot when performing a point-of-failure restore.

• Do not use third party tools, including SQL management studio, to create database backups
or transaction log backups.

• Verify if the database is online and visible under the Instance.

Procedure
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.
2. Locate the snapshot at an Instance or Database.
3. Select Actions→ Restore.
4. In the Restore dialog, select File Copy in the Restore Type drop-down.

Recovering Data with Auto-Restore 95



Figure 43 Restore using File Copy
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5. From a Database level, select any one of the following options:
• Clone Database
• Point in time with No Recovery
• Point of Failure: This option performs a tail log backup of the active transaction log;

restores in no recovery mode of specified point-in-time snapshot; replays the tail log
backup on the restored database; and removes the tail log backup file when all the
listed operations result in success.

NOTE:
• SQL services remains active during a Point of Failure restoration operation.

• When multiple database restore option is selected, SQL services stops and restarts
when operation is complete. Only point-in-time restore option is available with this feature
for this release.

• The Point of Failure restore is not supported for Instance-level snapshots.

6. Read the warning before checking the Click to continue box and click Restore to proceed
with restoration.

7. You can monitor the Restore Snapshot logs in the Activity Page.
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Performing a Volume Restore
1. Click HPE Recovery Manager Central→ Microsoft SQL Server.

All Snapshots are listed here.

Figure 44 Volume Restore at a Database Level

2. Locate the specific snapshot Management timestamp at an Instance or Database.
3. Read the warning before checking the Click to continue box and click OK to proceed with

restoration.
4. You can monitor the Restore Snapshot logs in the Activity Page.

NOTE: To ensure that all the disks are brought online after the volume restore operation, in
the DISKPART command set the parameter as san policy=online all.
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Performing volume and file copy restore for availability databases
Restoring primary database removes the database from the primary node and the secondary
nodes. RMC-S restores database only at the primary node. All secondary databases will be in
restoring state. All secondary databases must be restored manually after the restore operation
is completed on primary node by RMC-S.
To manually restore availability database on secondary replica node:
1. Take full backup of the availability database and transaction log at primary replica node.
2. Manually restore the secondary availability database and its log from the backup taken at

the primary replica node using RESTORE WITH NO RECOVERY option. If the primary
database and secondary database have different file paths, you must use the WITH MOVE
option.

3. Perform this restore sequence on every server instance that hosts a secondary replica for
the availability group.

4. Join the database to the Availability group.
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8 Coexistence of RMC-S and HP 3PARRecoveryManager
for Exchange

Prerequisites
• Only interface server component of RMC-S and HP 3PAR Recovery Manager for Exchange

applications can be installed on the same server.
• Mixing the interface server components and production server components in a coexistence

scenario is not supported.
• RMC-S and HP 3PAR Recovery Manager for Exchange applications must be installed and

launched independently.
• RMC-S must be in the same domain as Exchange server.
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9 Using HPE 3PAR Peer Motion Manager Software with
RMC-S

HPE 3PAR Peer Motion Manager is a feature of the HPE 3PAR Software and manages the
migration of data from a source storage system to a destination storage system. RMC-S now
supports HPE 3PAR Peer Motion Manager data migration activities without any impact on host
operations while monitoring the primary storage system.
For more information about performing Peer Motion data migration, see the HPE 3PAR Peer
Motion User Guide. Go to HP3PAR, navigate to your product page, click Support for your
product, and then click Manuals.

NOTE:
• Peer motion only from HPE 3PAR StoreServ to HPE 3PAR StoreServ is supported.

• RMC-S does not support volumes that are migrated from EVA to HPE 3PAR StoreServ.

• After the Peer Motion from HPE 3PAR StoreServ to HP 3PAR StoreServ is completed,
ensure that the new StoreServ is added to RMC as a storage system.

• Do an SQL Server Instance rescan before you perform any new operation.

NOTE: If the device is presented using Raw Device Mapping (RDM) and if peer motion is
performed on that device, the device must ignore the SCSI INQUIRY Cache.
To ignore the SCSI INQUIRY cache, configure the virtual machine using RDM as follows:
• Add the following parameter to the .vmx file:

scsi x:y. ignoreDeviceInquiryCache = "true"

where x is the SCSI controller number and y is the SCSI target number of the RDM.

This parameter can be configured only on virtual machines with hardware version 8. Upgrade
the virtual machine to hardware version 8 before adding this parameter.
Enable this parameter only when it is recommended by the storage vendor. This parameter is
required for a limited number of storage arrays and only for specific guest operating systems.
You must reboot the system for the changes to take effect.
Peer Motion Migration does not migrate snapshots. Therefore, the existing snapshots after
migration will not be available for use.
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10 Remote Copy for RMC-S
How Remote Copy Works

RMC-S supports the following remote copy group modes:
• Synchronous

• Asynchronous

• Periodic
When you synchronize data between a production system (the Remote Copy primary system)
on one site and the Remote Copy backup system at another site, the systems involved help you
perform the following steps.

PeriodicSynchronous or Asynchronous

Recovery Manager leverages the VSS framework to freeze the I/O at the application level and to take point in time
snapshots.

For periodic remote copy groups, after the remote
snapshots are created for the target LUNs, the remote

For Synchronous or Asynchronous remote copy groups,
HPE RMC VSS Provider leverages the co-ordinate

RMC-S interface server repository is updated with thesnapshot technology provided by the HPE 3PAR
time stamp of the remote snapshot created. The localStoreServ to create remote virtual copies (internally uses
RMC-S interface server does not retain any record of theRMC to connect with StoreServ). The local RMC-S
snapshot time stamp for the source LUNs of the remote
copy group in its repository.

interface server saves the time stamp record of the
Snapshts of a source LUN and remote RMC-S interface
server saves the same time stamp record of a remote
Snapshots in their respective repositories.

NOTE: User can make use of the Expiration policy settings of RMC-S. In this case, the retained
Virtual Copies are removed by the HPE 3PAR StoreServ after the expiration period has elapsed.

The following table explains the feature of Synchronous Long Distance (SLD):

Synchronous Long Distance

Recovery Manager leverages the VSS framework to freeze the I/O at the application level and to take point in time
snapshots.

For SLD remote copy groups, the RMC-S creation and snapshot timestamp retention in local and remote RMC-S
interface servers, depends upon the target HPE 3PAR StoreServ during RMC-S snapshot creation. If the target HPE
3PAR StoreServ which has Synchronous relationship with the source is selected, the behavior is same as that of
synchronous or asynchronous remote copy groups. If the target HPE 3PAR StoreServ which has periodic relationship
with the source is selected, the behavior is same as that of periodic RC groups.

NOTE: For SLD remote copy groups, RMC-S does not create Remote Virtual copies for the Synchronous,
Asynchronous, and Periodic target LUNs simultaneously. Remote Virtual Copy creation for the target LUN depends
upon the type of remote copy (sync/async/periodic) configured for SQL instance/database.

NOTE:
• Remote Copy is not supported for SQL Server 2012, 2014 Availability databases.

• For the RMC-S GUI to manage snapshots on the Remote Copy target interface server, you
must configure RMC-S with the precise SQL server and instance names for the supported
SQL servers.
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Figure 45 Remote copy configuration

Prerequisites
Before configuring the interface server ensure the following conditions are met:

• Recovery Manager for SQL license and Remote Copy license must be available on all
registered HPE 3PAR StoreServ.

• The Remote copy group volumes must be in synced and started state.

• All RMC Appliances and Interface Servers (Primary and Target) must communicate with
each other.

• For SLD Remote Copy configuration, you must configure two target interface servers for
SLD Remote Copy group associated with SQL server instance/database. One for
Synchronous mode and the other interface server for Periodic mode. For more information
on SLDRemote Copy configuration, see “Configuring RMC-S in a Remote Copy environment
” (page 20).

• Registering the RMC-S appliance that is managing target interface server is a prerequisite
for performing any Remote Copy operations. For more information on registering a Remote
appliance, see “Setting up a Remote Appliance” (page 104).

Setting Up Remote Copy
1. Install and configure Remote Copy. For more information on installation and configuration,

see HPE 3PAR Remote Copy Software User Guide.
2. After you have set up Remote Copy on two HPE 3PAR StoreServ, create a Remote Copy

volume group for testing.
3. Configure the Remote Copy volume group for synchronization in synchronous, async, or

asynchronous periodic mode with appropriate periodic value as supported by HPE 3PAR
StoreServ.

4. Set up a remote appliance.
5. In the source RMC-S GUI, register the SQL Remote Copy instances/database without the

Remote Copy option selected.
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6. In the target RMC-S GUI, register the SQL Remote Copy instances/database with the
Remote Copy option selected.

7. For SLD Remote Copy configuration, repeat Step 6 on both target RMC-S GUI.

NOTE:
• There is no separate configuration required for Remote Copy SLD configuration. If the SQL

server instance/database is configured for SLD Remote Copy, then you must select the
required target interface server to create Synchronous or Periodic snapshot.

• You cannot create local or Remote Copy snapshot from remote site interface server
configured RMC-S GUI.

Setting up a Remote Appliance
Registering the target interface server is mandatory for setting up Remote Copy configuration.

Registering an appliance
1. Select HPE Recovery Manager Central→ Settings→ Remote Appliances.
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2. Click +Remote Appliance or Register from the Actions menu.

NOTE: Actions menu appears only after a remote appliance is added.

Figure 46 Registering an appliance

Enter the following details to add a new appliance:

DescriptionNameTitle

Enter the IP address or the host name of the appliance.IP Address or Host
Name

Remote

Enter the user name to register with the appliance.Username

Enter the password to register with the appliance.Password

This helps to register the local appliance as remote appliance.Use Local
Appliance to
Manage Remote
Array

Local

Support for Remote Copy Modes and Policies
RMC-S supports Remote Copy in synchronous, asynchronous, and asynchronous periodic mode.

• If you are using synchronous or async mode, the policies on the production system (the
Remote Copy primary system) and the Remote Copy interface server must match. If the
policies do not match, RMC-S cannot create snapshots on a synchronous Remote Copy
system.

• Connect to the source RMC-S GUI, register the MS-SQL instance, and set the required
RMC-S policy for MS-SQL instance.

• Connect to the remote RMC-SGUI and register the sameMS-SQL instance. SelectRemote
Copy option while registering the MS-SQL instance.
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• On the Remote Copy in RMC-S GUI, make sure the policy is configured as the source
MS-SQL instance (as in step1).

• If you manually specify an expiration value or a retention value or both when creating a
snapshot, RMC-S creates the snapshot on a synchronous Remote Copy system if:

◦ The policy on the Remote Copy primary server and interface servers is an expiration
based policy.

◦ All policy values including retention values match.
You can specify only the retention value when you create a snapshot on synchronous Remote
Copy system. If the policy on both the Remote Copy primary servers and interface servers
is numeric, ensure all the policy values, including retention values match.

NOTE: For more information on specifying values snapshots, see the description of the
HpRmCli Sql create command in “Using RMC-S Command Line Interface” (page 68).

• If you are using asynchronous periodic Remote Copy, you can create RMC-S snapshots
even if policies on the servers do not match. If policies do not match, the snapshots use the
policies on the Remote Copy interface server.

• If you are running Remote Copy in a Synchronous Long Distance configuration, the snapshots
on the synchronous Remote Copy interface servers have the same timestamp. The snapshots
on the asynchronous periodic Remote Copy interface servers do not have the same
timestamp.

Setting Up Remote Copy Volume Groups
Setting Up a Remote Copy Volume Group for Databases

1. Identify the virtual volumes that contain the database and log files to be copied.

NOTE: RMC-S supports multiple databases in one Remote Copy volume group if all
databases in the group belong to the same instance.

2. Add virtual volumes belonging to the database and log files to the primary Remote Copy
volume group, and add the associated secondary virtual volumes to the secondary volume
group on the Remote Copy interface server.

CAUTION: Do not disperse files from one database over multiple primary Remote Copy
volume groups. RMC-S does not support database and log files from one database existing
in any location other than the one primary Remote Copy volume group created for that
database.

3. Synchronize the Remote Copy primary and secondary volume groups.

Setting Up a Remote Copy Volume Group for Instances
1. Identify the virtual volumes that contain all databases and log files to be copied.
2. Create one primary Remote Copy volume group for this instance.
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3. Add all virtual volumes that belong to this instance (all database and log files) to the primary
Remote Copy volume group, and add the associated secondary virtual volumes to the
secondary volume group on the Remote Copy interface server.

CAUTION: The relationship between instances and Remote Copy volume groups is 1:1.
• You must add files from only one instance to a primary Remote Copy volume group.

• You must add files from only one instance to one primary volume group.

◦ Do not disperse files from one instance over multiple primary Remote Copy volume
groups.

◦ Do not add files from multiple instances to the same Remote Copy volume group.

If these system requirements are not met, you might encounter data corruption and loss.

4. Synchronize the Remote Copy primary and secondary volume groups.

Recovering data from the secondary site
In case of primary site disaster, the remote Virtual Copies created at the secondary site prior to
disaster can be used to restore the data through file copy/volume restore operations. To achieve
this, ensure that the SQL server instance is online using the secondary site LUNs. For this, you
must have one of the following configurations:

DescriptionConfiguration

Failover
In case of disaster at the primary site, failover cluster
brings up the SQL server service online at Site B (CLX

Configuration: 1
SQL server cluster involving the nodes in primary and
secondary site: All instance and database LUNs must be

can be used to automatically switch the secondary sitea part of the same Remote Copy group. The primary site
LUNs to read/write mode). In the absence of CLX, younodes must have Remote Copy LUNs presented from
need to manually perform the failover using SSMC or CLIthe primary site and the secondary site nodes must have

Remote Copy LUNs presented from the secondary site. to switch secondary site LUNs to read/write mode (post
this, the SQL server cluster is brought online on the
secondary site nodes).NOTE: Only instance level Remote Virtual Copies can

be created in this case.
Failback
In case of failover, the SQL server cluster instance primary
site node(s). If CLX is used, the primary site Remote Copy
LUNs are automatically switched to read/write mode. If
not, manual fail back using SSMC or inform CLI to switch
primary site Remote Copy LUNs to read/write mode (after
this, the SQL server cluster is brought online to the primary
site nodes).

Failover
Post failover, during the Remote Virtual Copy restore
process, ensure that the RMC appliance registered in the

Configuration: 2
The primary site standalone SQL server must be
configured using the primary site Remote Copy LUNs and

secondary site production server is the same as the RMCsecondary site standalone SQLmust be configured using
appliance (the same remote appliance registered in thesecondary site Remote Copy LUNs. In case of disaster
primary site) registered in the secondary site interface
server (target interface server).

at the primary site, IMC or CLI must be used to manually
failover so that secondary site LUNs are switched to
read/write mode and the standalone SQL server must be Failback

After the primary site recovers from the disaster condition,
to resume snapshot creation or restore operations at the

brought online at the secondary site Windows host with
identical hierarchical structure as described in
Configuration: 1.
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DescriptionConfiguration

NOTE: Depending on the requirement, either instance
or database level Remote Virtual Copies can be created
in this case.

primary site, ensure that the setup is similar to how it was
before the disaster. For this:

• In case of standalone SQL server, manually failback
using SSMC or inform CLI such that primary site
Remote Copy LUNs are switched to the read/write
mode and bring the Standalone SQL server online at
the primary site windows host.

NOTE:
• Post failover, during the remote virtual copy restore process, ensure that the RMC appliance

registered in the secondary site production server is same as the RMC appliance (that is,
nothing but the remote appliance registered on the primary site) registered in the secondary
site interface server (target interface server). Use RMC registration tool to update the RMC
appliance details.

• Depending on the requirement, either instance or database level remote Virtual Copies can
be created in this case.

108 Remote Copy for RMC-S



11 Using HPE 3PAR CLX with RMC-S
SQL Server Failover Clustering is a shared storage failover cluster solution which consists of
two or more nodes. There is one copy of the SQL databases with this solution. However, because
this solution is based on a shared storage, third-party array-based replication solution like HPE
Remote Copy, synchronous and asynchronous replication can be used to have more than one
copy of the SQL databases.
RMC-S supports SQL server clustering and HPE 3PAR CLX configuration in conjunction with
Remote copy feature of RMC-S.
An interface server is required for each site corresponding to each array. If two arrays are
configured—one on a local site and one on a remote site, then there is a need for two interface
servers, once at each site.

Figure 47 Two Site Configuration

This figure is only an example of a two site configuration.
RMC-S supports only two-site configuration. Within each site, any number of nodes is supported.
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An interface server is required for each site corresponding to each array.
RMC VSA is required for each interface server. The interface server on each site must be
configured only with the array connected to the nodes on that site. For example, using RMC
registration tool ensure that you add only Site A array configuration on the Site A interface server.
Similarly on site B, configure only the site B array.
The interface server on each site can only manage the SQL server instances or databases, which
are owned by nodes on the respective sites.

NOTE: Ensure that only one array is configured on each interface server.

• The Create Remote snapshot operation must use “Remote snapshot” option. For more
information on using Remote Snapshot, see “Manually creating a snapshot” (page 49).

• This will ensure corresponding snapshot is created on other site.

• The remote site interface server information is required to specify as input for remote snapshot
operation. For more information on RMC-S remote copy, see “Remote Copy for RMC-S”
(page 102).

• The corresponding snapshot created on the remote site can be used for recovery operations
on the remote site.

Using snapshot operation without Remote Copy will only create a snapshot on the local site and
that can be managed only by local site interface server. In case of a site disaster, the production
volume cannot be recovered on the remote site as there would not be any snapshot on the remote
site corresponding the local Virtual Copies.
Each interface server can only manage the SQL server and its instance or databases that are
currently owned by the nodes on their respective sites.

NOTE: Cross-site management is not supported by RMC-S.

For example, in Figure 47 (page 109), the site A interface server can perform all operations on
the nodes on site A. For example, create snapshot on an instance or a database that are currently
owned by the nodes on site A. Site A interface server will not be able to perform any operation
on site B nodes, such as node 3 and node 4 as they are connected to a different array on site
B. Similarly, the same rules apply to site B interface server.

WARNING! Any attempt to perform cross-site operation will result in a failure.

SQL server and its instance or databases owned by one site can fail over to another site. In such
a scenario, the other site must be used for subsequent snapshot operations.
Recovery operation can only be performed on a site using the snapshot created on that site. If
there is a failover of the SQL server after snapshot creation, to use the snapshot for recovery,
the SQL server must fail back or must be moved back to the earlier node where the snapshot
was created.
Cluster Virtual Network Name (VNN) must be used for registering SQL server to RMC-S. Cluster
VNN must be used when a mount needs to be done to an owning node. The command is
automatically directed to the owning node. However, if the current owning node has crossed over
to the other site (remote site) due to failover or planned movement, then the mount operation
fails. In such a scenario, the other interface server must be used for the mount operation.
RMC-S supports Synchronous remote copy configurations.
In Synchronous remote copy, RMC-S creates a snapshot first on the local site and then on the
remote site. Therefore, snapshot management such as mount, recovery, and backup can be
performed on both the sites.
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12 Support and Other Resources
Related Documents

Read the…For information on

HPE 3PAR Command Line Interface Administrator’s
Manual

Using the HPE 3PAR OS Command Line Interface (CLI)
to configure and manage the HPE 3PAR StoreServ
Storage System

InForm Management Console Help Release 4.7Using the HPE 3PAR Management Console to configure
and administer HPE 3PAR StoreServ Storage Systems

HPE 3PARStoreServ Storage Concepts Guide (OS 3.1.3)Assigning the appropriate user roles and rights
HPE 3PAR Command Line Interface Administrator’s
Manual

HPE 3PAR InForm OS Messages and Operator’s GuideIdentifying HPE 3PAR StoreServ Storage System
components and fixing problems

HPE 3PARStoreServ Storage Concepts Guide (OS 3.1.2)Understanding the HPE 3PARStoreServ Storage System
and its features

For information about supported hardware and software
platforms, see the Single Point of Connectivity Knowledge

Platform-specific release levels

for HPE Storage Products (SPOCK) website: http://
www.hp.com/storage/spock.

Typographical Conventions

ExampleMeaningTypeface

Enter your system name in the Value
box and click OK.

Used for dialog box elements, such
as titles and button labels.

ABCDabcd

Found < 12 > 73G disks. Enter
cli at theWindows command prompt.

Used for file names, paths, and
screen output, and for text you are to
enter.

ABCDabcd

cli% removevv VV1 Removing vv
VV1.

Used to contrast your input with
system output.

ABCDabcd

[root@(systemID-nodeID)root] To
continue enter your system
name ==> systemname

Used for variables in file names,
paths, and screen output, and for
variables in user input.

ABCDabcd

ABCDabcd

NOTE: The InServ Storage Server is rebranded as HPE 3PAR StoreServ Storage System.
There are instances in this document where screenshots or menu items or both and command
output, see HPE 3PAR StoreServe Storage System as InServ or InServ Storage Server.
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Advisories
To avoid losing or damaging data, be sure to observe the cautions and warnings in this document.

WARNING! Warnings alert you to actions that can cause injury to people or irreversible damage
to data or the operating system.

CAUTION: Cautions alert you to actions that can cause damage to equipment, software, or
data.

NOTE: Notes are reminders, tips, or suggestions that supplement the procedures included in
this document.

Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support
Center website:
www.hpe.com/support/hpesc

Information to collect
• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Technical support registration number (if applicable)

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

• vCenter Server and HP OneView for VMware vCenter log files
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Accessing updates
• Some software products provide a mechanism for accessing software updates through the

product interface. Review your product documentation to identify the recommended software
update method.

• To download product updates, go to either of the following:

Hewlett Packard Enterprise Support Center Get connected with updates page:
www.hpe.com/support/e-updates

◦

◦ Software Depot website:
www.hpe.com/support/softwaredepot

• To view and update your entitlements, and to link your contracts and warranties with your
profile, go to the Hewlett Packard Enterprise Support CenterMore Information on Access
to Support Materials page:
www.hpe.com/support/AccessToSupportMaterials

IMPORTANT: Access to some updates might require product entitlement when accessed
through the Hewlett Packard Enterprise Support Center. You must have an HP Passport
set up with relevant entitlements.

Websites

LinkWebsite

www.hpe.com/info/enterprise/docsHewlett Packard Enterprise Information Library

www.hpe.com/support/hpescHewlett Packard Enterprise Support Center

www.hpe.com/assistanceContact Hewlett Packard Enterprise Worldwide

www.hpe.com/support/e-updatesSubscription Service/Support Alerts

www.hpe.com/support/softwaredepotSoftware Depot

www.hpe.com/support/selfrepairCustomer Self Repair

www.hpe.com/info/insightremotesupport/docsInsight Remote Support

www.hpe.com/info/hpux-serviceguard-docsServiceguard Solutions for HP-UX

www.hpe.com/storage/spockSingle Point of Connectivity Knowledge (SPOCK) Storage
compatibility matrix

www.hpe.com/storage/whitepapersStorage white papers and analyst reports

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product.
If a CSR part needs to be replaced, it will be shipped directly to you so that you can install it at
your convenience. Some parts do not qualify for CSR. Your Hewlett Packard Enterprise authorized
service provider will determine whether a repair can be accomplished by CSR.
For more information about CSR, contact your local service provider or go to the CSR website:
www.hpe.com/support/selfrepair

Accessing updates 113

www.hpe.com/support/e-updates
http://www.hpe.com/support/softwaredepot
http://www.hpe.com/support/AccessToSupportMaterials
http://www.hpe.com/info/enterprise/docs
http://www.hpe.com/support/hpesc
http://www.hpe.com/assistance
http://www.hpe.com/support/e-updates
http://www.hpe.com/support/softwaredepot
http://www.hpe.com/support/selfrepair
http://www.hpe.com/info/insightremotesupport/docs
http://www.hpe.com/info/hpux-serviceguard-docs
http://www.hpe.com/storage/spock
http://www.hpe.com/storage/whitepapers
http://www.hpe.com/support/selfrepair


Remote support
Remote support is available with supported devices as part of your warranty or contractual support
agreement. It provides intelligent event diagnosis, and automatic, secure submission of hardware
event notifications to Hewlett Packard Enterprise, which will initiate a fast and accurate resolution
based on your product’s service level. Hewlett Packard Enterprise strongly recommends that
you register your device for remote support.
For more information and device support details, go to the following website:
www.hpe.com/info/insightremotesupport/docs

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To
help us improve the documentation, send any errors, suggestions, or comments to Documentation
Feedback (docsfeedback@hpe.com). When submitting your feedback, include the document
title, part number, edition, and publication date located on the front cover of the document. For
online help content, include the product name, product version, help edition, and publication date
located on the legal notices page.
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A RMC registration tool
• Run the executable rmcregistration.exe (RMC registration tool) to manually register

the RMC appliance on the interface and production servers. The rmcregistration.exe
file is provided with HPE RMC VSS provider.

• The rmcregistration.exe file is available under the installation path of HPE RMC VSS
provider. For example, C:\Program Files\HPE\RMC\Provider.

• You can set the default target storage system using the rmcregistration.exe file.
• If RMC instance is already registered, click rmcregistration.exe file. The following

dialog appears:

Figure 48 RMC registration tool

1. Click Yes to set the default target storage system. Click No to update RMC details and
modify or set the RMC IP address.
The following screen appears:

Figure 49 RMC appliance credentials
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2. Enter the following details:

DescriptionName

Enter the hostname or IP address of RMC.HPE RMC hostname/IP

Enter the RMC credentials.HPE RMC username

HPE RMC password

If Yes in HPE RMC dialog box, select Fetch from the list to retrieve the configured
storage system on HPE RMC hostname/IP.

NOTE: The field is disabled if you select No in the HPE RMC dialog.

Default Storage System

NOTE:
• Use the RMC registration tool to mount a snapshot on a remote server, edit the

registration, and mount the snapshot.
• The RMCRegistration tool displays HPE 3PAR StoreServ system ID inDefault Storage

System. The following example maps the correct HPE 3PAR StoreServ System ID
using the HPE 3PAR StoreServ CLI command.
If HPE 3PAR StoreServ serial number is 1647290, then the last 5 characters of the
serial number is the HPE 3PAR StoreServ System ID. If you do not find this mapping
in your configuration, then use the following HPE 3PAR StoreServ CLI command to find
the correct mapping of HPE 3PAR StoreServ serial number and HPE 3PAR StoreServ
System ID.
For example,
$showsys -d

Output of the command
--------------General--------------
System Name : ndu_3par_01
System Model : HP_3PAR 7400
Serial Number : 1647290
System ID : 47290
Number of Nodes : 4
Master Node : 0
Nodes Online : 0,1,2,3
Nodes in Cluster : 0,1,2,3
Chunklet Size (MB) : 1024

Description
StoreServ Name is storeServ_test
StoreServ System Model: HP_3PAR_7400
StorServ Serial number : 1647290
StoreServ System ID: 47290

NOTE: If HPE 3PAR StoreServ serial number is 10 characters in length, then HPE
3PAR StoreServ System ID might be in hexadecimal format and RMC Registration tool
will list HPE 3PAR StoreServ System ID in decimal format. Run the showsys -d
command to convert from hexadecimal format to decimal format. For example, HPE
3PAR StoreServ System ID 0x187B4 in hexadecimal format is listed in the decimal
format as 100276 in the Default Storage System field.
You can convert from hexadecimal to decimal using calc.exe on Windows systems.
Use the View Programmer option to convert.
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B Server Virtualization Environments
VMware and Microsoft Hyper-V Environments

VMware and Microsoft Hyper-V environments are supported under specific conditions in an FC
configuration. For VMware and Microsoft Hyper-V support in a virtualization environment, the
setup must meet the following requirements in an FC configuration:
• The disks presented to the SQL servers must be physical devices.
• The interface server must be connected directly to the HPE 3PARStoreServ Storage System.

The interface server cannot be connected to the HPE 3PAR StoreServ Storage System
through VMware or Microsoft Hyper-V in an FC configuration.

• You cannot run the HpRmCli Sql mount command against a VMware or Microsoft Hyper-V
server in an FC configuration.

NOTE:
• New volumes presented to VMware and Microsoft Hyper-V servers are not surfaced

automatically. You must use the backup host to mount the servers with the HpRmCli Sql
mount command. Therefore, you cannot use either File Copy Restore or Volume Restore
to directly restore an SQL server that resides in a virtualized FC configuration environment.

• An iSCSI setup is supported in an interface server operating in a Microsoft Hyper-V and
VMware ESX(i) Virtual Machine.

• Microsoft Windows 2012 / 2012 R2 with VFC are supported on the interface server. Make
sure that the VM that is enabled with VFC HBA is zoned with HPE 3PAR properly to facilitate
mount operations on the interface server.

Figure 50 (page 118) shows the relationships between the HPE 3PAR StoreServ Storage System
and VMware and Microsoft Hyper-V servers in a virtualization environment.

Figure 50 Server Virtualization Environment
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C Manually importing/restoring interface server catalog
dumps

Perform the following steps after downloading the interface server catalog.zip file from the
RMC Import dialog.
1. After the Catalog file is download from the interface server, navigate to the interface server

installation directory. For example, <installation directory>:\Program
Files\HPE\RMC-S\SQL.

2. Copy the .zip file named in the format: RMS-<IP ADDRESS>-MigData.zip. For example,
RMS-15.213.67.225-MigData.zip to the following directory: <installation
directory>:\Program Files\HPE\RMC-S\SQL.

3. Extract the .zip file to a temporary folder on the server.
The following folders and files are extracted:
• Data (folder)
• [Content_Types] (xml file)

4. Copy the contents of the Data folder to the following target directory <installation
directory>:\Program Files\HPE\RMC-S\SQL\Data. If the customer has migrated,
then the target directory is <installation directory>:\Program
Files\3par\RM\SQL\Data.

NOTE: If data exists in the Data folder, make sure to clean up the folder and then copy
the data files into this directory.

5. Refer to the Catalog Scenario to make sure that the configurations are appropriate after
restore.

6. Restart the interface server.
7. Log in to the RMC appliance to verify the restored data.

Restoring Catalog scenarios
Restore Catalog is classified into the following scenarios.

NOTE: Auto discovery does not list the re-registered instances.

• Scenarios — 1: Fresh installation of RMC and interface server
• Scenarios — 2: Existing RMC and fresh installation of interface server
• Scenarios — 3: Fresh installation of RMC and existing interface server
• Scenarios — 4: Existing RMC and existing installation of interface server
• Scenarios — 5: Existing RMC and existing interface server with IP changed

Fresh installation of RMC and interface server
RMC catalog is restored to a different interface server configured with a fresh installation of RMC.
1. If the catalog is already restored, youmust register RMCmanually on all registered production

servers with the RMC registration tool.
or

2. Youmust manually re-register the production server instances from the RMCGUI with Force
Register even if the instance is in managed state.

Existing RMC and a new interface server setup
RMC catalog is restored to a different interface server configured with the same RMC.
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1. If the catalog is already restored, you must register RMC manually on all production servers
with the RMC registration tool.
or

2. Youmust manually re-register the production server instances from the RMCGUI with Force
Register even if the instance is in managed state.

Fresh installation of RMC with an existing interface server
RMC catalog is restored to an existing interface server and the protected RMC catalog is restored
on a different RMC appliance.
1. RMC catalog is restored to a same interface server configured with a different RMC where

catalog was protected RMC.
or

2. Youmust manually re-register the production server instances from the RMCGUI with Force
Register even if the instance is in managed state.

Existing RMC and existing installation of interface server
RMC catalog is restored on an existing RMC and the interface server catalog is restored on an
existing interface server.
1. You must verify if all the registered hosts have the same RMC registered, if not you must

register RMC using the RMC registration tool.
or

2. Youmust manually re-register the production server instances from the RMCGUI with Force
Register even if the instance is in managed state.

Existing RMC and existing interface server with changed IP
RMC catalog is restored on an existing RMC and the interface server catalog is restored on an
existing interface server. In this scenario, the IP addresses of RMC and the interface server are
changed.
1. Verify if RMC is registered on the interface server and the registered production server. If

RMC is not registered you must register RMC using the RMC registration tool.
or

2. a. Unregister the interface server from RMC GUI with Force Un-Register. Select the force
unregistration option if normal unregistration fails before catalog restore.

b. Register the interface server with or without force option.
c. Restore a catalog.
d. You must manually re-register the production server instances from RMC GUI with

Force Register even if the instance is in managed state.
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D Troubleshooting
This appendix is designed to be used like a Frequently Asked Questions section. It will help you
find solutions to some of the common issues that might arise when running RMC-S.
Problem
Recovery Manager displays error message “VSS_E_PROVIDER_VETO.”
Suggestion
Check the application event log and VSS provider log from the production server. If you see
“Maximum of 28 writable snapshots per volume is allowed,” your snapshot capacity might be full.
This error usually occurs when you mount a snapshot. Unmount several snapshots and continue
the mount procedure.
Problem
A restore of a backup, which was created using Symantec NetBackup via the RMC for SQL GUI,
fails.
Suggestion
When you use the Recovery Manager GUI to back up a snapshot using Symantec NetBackup
and a directory is specified for backup, you must enter the directory name and path precisely,
including the upper and lower case (for example, MuTenFF). If the names do not match exactly,
a restore of this backup fails as Symantec NetBackup is case-sensitive.
When protecting a directory, specify the directory in exactly the same case as it exists on the file
system.
Problem
When you create a snapshot on a SAN boot disk, the snapshot creation fails with error
“Error-VSS_E_HOLD_WRITES_TIMEOUT.” The in-box systemwriter that enumerates all operating
system and driver binaries is included as well. The error usually occurs because the I/O cannot
hold the system writer.
Suggestion
HPE does not recommend placing a database on the SAN boot disk. Place all important databases
on separate SAN disks.
Problem
As data blocks are copied per the copy-on-write technology, the space for virtual copies on the
virtual volume might become 100% full either if snapshot space was statistically allocated as a
percentage of the virtual volume, or if there is no additional space available for the CPG to
auto-grow. If the space for Virtual Copies on a virtual volume becomes 100% full, the Virtual
Copies on the virtual volume might become invalid and subject to the RMC-S policy.
Suggestion
Allocate more snapshot space when creating virtual volumes during base volume creation, or
use CPGs to manage the data generated by copy-on-write technology.
Problem
GUI and CLI commands fail after installing RMC-S.
Suggestion
If you install Recovery Manager via a remote desktop session, the newly added environment
variables do not come into effect until you log out of the session. (If Recovery Manager is installed
directly from the system console, these variables must be available immediately.)
Problem
Symantec NetBackup takes a substantial amount of time to complete a backup process.
Suggestion
Make sure you have the latest maintenance package installed for your NetBackup application.
Problem
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Recovery Manager is running in a Windows cluster environment and the application event log
displays the Volume Shadow Copy Service error: “Unexpected error querying for the
IVssWriterCallback interface. Access is denied.”
Suggestion
Reconfigure the security settings for the cluster environment as follows:
• Ensure that Failover Cluster MS DTC is installed. Failover Cluster MS DTC is required for

the following procedure:
1. ClickStart→Run→dcomcnfg orStart→Administrative Tools→Component Services.
2. Expand Component Services and click Computers.
3. Right-click My Computer and select Properties.
4. Select the COM Security tab.
5. Under Access Permissions, click Edit Default.
6. Add a Cluster Service account and select Local Access and Remote Access.
7. Reboot the machine.
8. Perform these steps on the second node.

Problem
You attempt to perform a media restore using the Recovery Manager CLI -ts command and
the attempt fails.
Suggestion
If the restore log contains the error message: “client <client> peer name <peer name> is
invalid for restore request,” the restore client is different from the backup client. Configure
Symantec NetBackup to perform a redirected media restore as follows:
1. Create an altnames directory on the NetBackup master server in the directory containing

the backup policy for other clients:
Install_path\NetBackup\db\

2. Place an empty file named No.Restrictions in the altnames directory:
Install_path\NetBackup\db\altnames\No.Restrictions

Do not add a suffix to the files in the altnames directory.
3. Ensure that the NetBackup client name on the requesting client matches the name of the

client for which the backup was created. (The peer name of the requesting client need not
match the NetBackup client name.)

Problem
When using Symantec NetBackup, the followingmessage appears: 0x1: ERROR: Cannot connect
to [NBU server name]; socket error.
Suggestion
Check whether you are using a different version of the NBU master server and the NBU client.
If so, upgrade the NBU client to the same version as the NBU master server.
Problem
Backup Exec does not invoke post job command in the following cases:
• Media configured for backup is offline.
• Media configured for backup is running with low space.
• Network issue.
In such cases, the impact on RMC-S is:
1. Backup time stamp will be empty.
2. In case of one click backup, though the snapshot is marked for deletion, the snapshot does

not get removed.
3. Snapshot will not be unmounted.
Suggestion
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Manually run the postbackup commands
hprmcli sql postbackup –s <servername>[ -i <instancename> ] -t <timestamp> [ -d <database>]
-r <Backup status>
–s <servername> The SQL server associated with the database.
-i <instancename> Optional. The SQL server instance associated with the database.

If not specified, MSSQLSERVER (local) is used as the default value.
-t <timestamp> The timestamp of the snapshot to back up.
-d <database> Optional. The database for the snapshot. If not specified, the

instance for the snapshot is used as the default value.
–r <Backup status> Backup completion status in NBU, DP, or BE. If backup completed

successfully then backup status will be 1 else it will be 0.
Problem
After volume promote, on few occasions, the volume involved in the restore operation might not
come online.
Suggestion
From the Disk Management utility of the server, select the volumes involved in Restore operation
andmanually make them online. If the problem persists, present the LUNwhich was to be restored
to the same host again through StoreServ Management Console (SSMC) using a LUN ID different
from the original LUN ID.
Problem
After database snapshot volume is restored or HPE StoreOnce Protect is restored or Catalyst
Copy Express Protect is restored on few occasions, the SQL instance service involved in the
restore operation might be stopped after restore is successful.
Cause
This issue appears when the user and system databases are residing on the same HPE 3PAR
volume (not a recommended configuration). The SQL instance service gets terminated during
restore operation because underlying volume is unexported during restore process. This issue
is also noticed in SQL cluster configuration on few occasions.
Resolution
Restart the SQL instance and its dependent services manually after the restore is completed
successfully.
Problem
Point of failure (using Auto restore) fails if, earlier the snapshot is recovered manually using Point
in time and No recovery option.
Suggestion
Do not use any third party software or SQL management studio for protecting the transaction
logs. Doing so will result in RMC-S not having the Transaction log backup sequence and this
results in the failure of point-of-failure restore operation.
Problem
If RMC-S server is in the workgroup and is managed by RMC-S interface server, then one click
protect fails.
Suggestion
Symantec NetBackup must be installed using custom installation option and registration of the
Symantec Netbackup service during the time of installation must be done explicitly using work
group privilege.

NOTE: The name is case sensitive. When checking iSCSI hostname, exclude the iqn number
from the name mentioned in the iSCSI initiator's configuration tab.

For example,
If host side iqn number is iqn.1991-05.com.microsoft:rmsbackupsvr.2k10vfc.com,
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hostname created on HPE 3PAR Storeserv side must be rmsbackupsvr.2k10vfc.com
Problem
NetBackup jobs sometimes complete with “Partial Backup status" as seen in NBU activity monitor.
Suggestion
This can happen when Provider Type option below Snapshot Client is set to 0 (Auto). To resolve
this issue, set the Provider type value to 1 (System). After the changes, restart the NBU services.
Problem
Recovery Set update operations culminate in failure and are declared as failed jobs in activity
page during NBU 7.5 backup operations despite a successful backup operation.
Suggestion
To avoid RMC-S performing the recovery set update operations during NBU 7.5 backup, perform
the following steps:
1. Select the NBU policy created, right–click, and select Change.
2. Select Perform snapshot backups in the Snapshot Client section.
3. Click Options in Snapshot Client section.
4. Select VSS in the Snapshot method drop-down and change the provider type to 1.
5. Click OK to save changes.
Problem
When the attach operation fails during snapshot mount operation, the snapshot must be
unmounted automatically.
Suggestion
You can manually attach mounted snapshot using SQL Management studio.
Problem
If a user tried to use multiple user credentials with the same UNC path for login at the same time.
Suggestion
The following are the suggestions to the problem:
• If you have to use a different user name to connect, then connect to UNC using an IP address

or other alias so that it seems like it is on a different path. This is recommended by Microsoft.
• Release the control to the UNC path using net use /delete UNC command.
• You must restart only the interface server.
Problem
When you register an interface server from the RMC GUI, the following error message appears:
RMCS 1100: Unknown internal error encountered, verify log.
Cause
If you use different login credentials for connecting to Universal Naming Convention (UNC) from
one or more RMC appliances, this error occurs.
Resolution
• Workaround 1

Connect to UNC using an IP address or alias so that it appears to be from a different path.
This workaround is recommended by Microsoft.
For more information, see Microsoft KB article 173199.

• Workaround 2
Release the UNC control path using net use /delete <UNC> command.

• Workaround 3
If the preceding workarounds do not work, restart the interface server.

Problem
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Not able to connect to SQL server instance or SQL connectivity test fails.
Cause
The reasons for the failure of the tests are:
• Network connectivity can be down.
• SQL service is down.
• Authentication problem.
Resolution
1. Log in to the SQL production server as system administrator and check connectivity:

• From the SQL production server, launch SQL Server Management Studio to make sure
the connection can be made locally.

• From Management Studio, right-click SQL server→Properties→Connections.
Make sure the Allow remote connections to this server box is selected.
• Make sure the SQL server for that instance has a status of started.
• For named instances, make sure the SQL server browser has a status of started.
• Double-check the settings under Properties→ Security.
• Double-check the settings under Properties→ Permissions.

2. After you have checked the SQL configuration on the production server, log onto the interface
server and run the SQL connectivity test again.

NOTE: Your interface server must pass this SQL connectivity test before you can use
RMC-S.

3. Verify that the SQL Server Browser service is running. Start the service if it is not running.
Problem
Creating a snapshot of a database instance returns the following error:
RMC5315: ERROR: Not Found: The requested URI was not found on RMC server.
Cause
This issue appears when the Recovery Set is deleted using the RMCGUI or RMC VM is deployed
using the same IP address of the deployed RMC VM.
Resolution
Run the following command on the associated interface server:
hprmcli sql policy -s <SQL Server> [-i <SQL instance>] [-d <SQL instance>] -resetRS

For example,
• To reset the SQL instance inst1 on SQL server sql1 run the following command:

hprmcli sql policy –s sql1 –i inst1 –resetRS.

• To reset the database db1 for instance inst1 on SQL server sql1 run the following command:
hprmcli sql policy –s sql1 –i inst1 –d db1 -resetRS.

• To reset the default instance on SQL server sql1 hprmcli sql policy –s sql1
-resetRS.

• To reset the database db1 of default instance inst1 on SQL server sql1 run the following
command:
hprmcli sql policy –s sql1 –d db1 -resetRS

Local communication port is 9932.

Validating server [RMS-9-237] connection...

WARNING: You are about to reset associated recovery-set data.
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Are you sure you want to reset?

Select Y/y=Yes N/n=No:

Enter Y or y to proceed. Retry creating snapshot.

Problem
Snapshot mount operation fails when iSCSI IQN number for target server is not the same as IQN
number listed against it in HPE 3PAR StoreServ.
Resolution
HPE recommends that iSCSI IQN number must be same in the target server and in the HPE
3PAR StoreServ host.
Problem
RMCS Scheduler fails to execute.
Cause
The following are the causes:
• You may have changed the RMC IP address after creating RMC-S schedules and Post IP

Change, all RMC-S schedules are failing.
• After importing the Catalog to new RMC (new IP), all RMC-S schedules are failing.
Problem
The error message Unable to retrieve microsoft sql server appears when RMC-S
GUI login session is opened for more than an hour.
Cause
This issue appears when the RMC GUI is timed out.
Resolution
Log out and log in to RMC-S GUI to continue your operations.
Problem
Performing snapshot operations of SQL instance or database after using IMC/SSMC to change
HPE 3PAR StoreServ operations, such as:
• Modifying HPE 3PAR LUN name or size.
• Unexported HPE 3PAR LUN from host.
• Exported HPE 3PAR LUN back to host.
• Host name change.
• Host WWN/iSCSI IQN number change.
returns the following error message: Create Failed with Exception : [ Failed to
create snapshot, please check the application and system event logs on
the SQL server for the most recent error. (Server : Server name ).
Resolution
1. Go to HPE Recovery Manager Central→Microsoft SQL Server.
2. From the Actionsmenu, select Analyze enable the check box Synchronize Results with

Repository and click Yes. Perform the snapshot operation after Analyze task is complete.
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E Event Messages
This appendix provides information on the event messages generated by RMC-S.

Table 3 RMC-S Server Event Messages

Description/ActionEvent MessageEvent ID

Some target volumes are not HPE 3PAR virtual volumes. All
drives must be HPE 3PAR drives.

• Verify that all database and log destinations belong to an
HPE 3PAR StoreServ Storage System.

RMS5312: ERROR: Some of the
volumes are either non3PAR volumes or
unsupported types of disk drives.

5312

The Remote Copy volume group is not configured for the
specified SQL database or instance.

RMS5313: ERROR: Couldn't find the
Remote Copy group for the specified
volume.

5313

• Check the Remote Copy configuration and HPE 3PAR
StoreServ Storage System setup.

• Consult the HPE 3PAR InForm OS CLI Administrator's
Manual or the HPE 3PAR Management Console Help for
details on setting up and checking Remote Copy
functionality.

To create a snapshot of an SQL database or instance, the
virtual volumes configured to store SQL database and log files

RMS5314: ERROR: The number of
virtual volumes used to create the

5314

must match the virtual volumes configured in the Remote Copy
volume group.

snapshot does not match the number of
virtual volumes in the Remote Copy
group. • Check the Remote Copy configuration and HPE 3PAR

StoreServ Storage System setup.

• Consult the HPE 3PAR InForm OS CLI Administrator's
Manual or the HPE 3PAR Management Console Help for
details on setting up and checking Remote Copy
functionality.

The repository might be out of sync.

• Run HpRmCli Sql analyze to list the out-of-sync entries.

RMS5319: ERROR: The snapshot was
not found in the repository.

5319

To use an alternate (nondefault) mount point directory in the
HpRmCli Sql mount command, you must first create the
mount point directory.

RMS5321: ERROR: The specifiedmount
directory does not exist.

5321

• Verify that the mount point directory exists.

• Alternatively, do not specify a mount directory. If an
alternate directory is not specified, RMC-S uses the default
mount directory.
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Table 3 RMC-S Server Event Messages (continued)

Description/ActionEvent MessageEvent ID

When you created the snapshot, RMC-S could not store the
snapshot timestamp in the repository for the specified
snapshotset ID.

• Wait a few minutes and then retry the operation.

RMS5325: ERROR: The snapshot
timestamp does not exist for the
snapshotset ID.

5325

A failure occurred when restoring data using the volume restore
feature. The failure might leave the HPE 3PAR StoreServ
Storage System in an inconsistent state.

• If the VLUNs are missing, ensure that they are recreated.

RMS5326: ERROR: Volume Restore
failed.

5326

Some of the database or log files are stored on volumes
created on dynamic disks.

• Ensure that the database and log files reside on volumes
created on basic disks.

RMS5327: ERROR: One or more of your
volumes are on dynamic disks. Dynamic
disks are not supported.

5327

Some of the database or log files are stored on the system
volume.

• Ensure that the database and log files are on HPE 3PAR
virtual volumes.

RMS5328: ERROR: One or more of your
databases are on the system volume.
You cannot create Virtual Copies of
system volumes.

5328

Performing a restore from backup does not overwrite an
existing copy of the same file.

• Verify that the specified restore folder is empty and try the
operation again.

RMS5329: ERROR: The destination file
already exists. Specify a different restore
location and try the operation again.

5329

SqlServerWriter was not found on the SQL Server.RMS5332: ERROR: Could not find the
SQL Writer. Either the Writer is not
installed or is currently not running.

5332

• Run the vssadmin list writers command and verify
that SqlServerWriter is listed.

• Ensure that the SQLWriter service is in theRunning state.

There are no Remote Copy volume groups configured on the
HPE 3PAR StoreServ Storage System. Ensure the Remote

RMS5333: ERROR: Remote Copy
groups are not configured. A Remote

5333

Copy volume group is configured before you create a remote
snapshot.

Copy group must be present to perform
this operation.

• Check the Remote Copy configuration and HPE 3PAR
StoreServ Storage System setup.

• Consult the HPE 3PAR InForm OS CLI Administrator's
Manual or the HPE 3PAR Management Console Help for
details on setting up and checking Remote Copy
functionality.
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Table 3 RMC-S Server Event Messages (continued)

Description/ActionEvent MessageEvent ID

The specified mount point drive letter is already in use.

• Be sure to specify an unused drive letter as a mount point
when you enter the HpRmCli Sql mount command.

RMS5335: ERROR: Mount point drive
letter is already in use.

5335

The specified mount point is not a directory.

• Be sure to specify a valid directory as a mount point when
you enter the HpRmCli Sql mount command.

RMS5336: ERROR: Mount point
directory is not a valid directory.

5336

The mount point directory specified already contains files.

• Be sure to specify a valid directory as a mount point when
you enter the HpRmCli Sql mount command.

RMS5337: ERROR: Mount point
directory is not empty.

5337

Symantec NetBackup installation information could not be
retrieved from the registry.

RMS5347: ERROR: Failed to locate
NetBackup installation. Pleasemake sure
NetBackup is correctly installed.

5347

• Verify that NetBackup is properly installed and that you
have access to the registry entry.

• Use Add/Remove Programs to confirm that NetBackup is
installed.

The NetBackup start or end scripts could not be found in the
RMC-S installation folder.

• Ensure that the bpstart_notify.bat and
bpend_notify.bat files are present in the RMC-S
installation folder.

RMS5348: ERROR: Could not find
NetBackup start and end scripts.

5348

Unable to open or create the NetBackup include file for the
specified policy. You can run only one backup job per policy
at a time on a NetBackup client.

• Ensure that no other HpRmCli Sql backup command
with same policy is running. Wait for the prior backup
command to complete and try again.

RMS5349: ERROR: Failed to create or
open backup include file for NetBackup.

5349

The NetBackup restore failed.

• On the NetBackup server, check the application event log
and NetBackup logs.

RMS5351: ERROR: NetBackup restore
process has failed.

5351

SqlServerWriter could not find the specified database in its list
of databases supported for backup.

RMS5354: ERROR: The SQL database
was not found in the SQL Writer
database list.

5354

• Verify that the database is online and attached.

• Ensure that the database is not a snapshot/mirrored
database.
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Table 3 RMC-S Server Event Messages (continued)

Description/ActionEvent MessageEvent ID

The expiration time for a snapshot must be a value between
0 and 43,800 hours (or between 0 and 1825 days).

• Try again, using a value within the range allowed.

RMS5356: ERROR: The expiration time
is out of range (0h - 336h).

5356

The NetBackup backup process has failed.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

RMS5364: ERROR: Failed to back up
the snapshot. Consult the backup
progress logs for details.

5364

An unexpected error occurred.

• For more details, check the logs in the RMC-S installation
folder and the event logs.

RMS5367: ERROR: Unknown error
encountered. See the logs for more
information.

5367

The policy was not found in the NetBackup database.RMS5370: ERROR: The specified policy
does not exist in the NetBackup
configuration database.

5370

• Verify that the policy is valid.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

The schedule was not found in the NetBackup database.RMS5371: ERROR: The specified
schedule does not exist in the
configuration database.

5371

• Verify that the policy is valid.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

RMC-S could not connect to the NetBackup server.RMS5372: ERROR: Failed to connect to
the NetBackup master server.

5372

• Ensure that you can connect to the NetBackup master
server.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

The backup cannot be created because no storage units are
available.

RMS5373: ERROR: No storage units
available for use.

5373

• Ensure that the storage units are configured and available
for use.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

The process cannot continue because the policy is not a valid
client type.

RMS5374: ERROR: The specified policy
is not a valid client type.

5374

• Ensure that the policy is a valid client type.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

The NetBackup server is not currently allowing this operation.RMS5375: ERROR: This operation is not
allowed at this time.

5375

• Wait some time and try the operation again.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

RMC-S cannot locate the client in the policy specified.RMS5376: ERROR: The specified client
does not exist in the specified policy.

5376

• Verify that the client is correctly configured for the specified
policy.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

130 Event Messages



Table 3 RMC-S Server Event Messages (continued)

Description/ActionEvent MessageEvent ID

To create backups, the policy used to create the backup must
be active.

RMS5377: ERROR: The specified policy
is not active.

5377

• Verify that the specified policy is active.

• For more details, check the application event log and
NetBackup logs on the NetBackup server.

RMC-S failed to mount the snapshot.

• Check the application and system event logs for the most
recent error messages.

RMS5379: ERROR: Failed to mount
snapshot. Please check the application
and system event logs for the most
recent error.

5379

RMC-S failed to create the snapshot.

• Check the application and system event logs on the SQL
server for the most recent error messages.

RMS5380: ERROR: Failed to create
snapshot. Please check the application
and system event logs on the SQL server
for the most recent error.

5380

The HPE Data Protector installation information could not be
retrieved from the registry.

RMS5381: ERROR: Failed to locate Data
Protector installation. Please make sure
Data Protector is correctly installed.

5381

• Verify that Data Protector is properly installed and that you
have access to the registry entry.

• UseAdd/Remove Programs to confirm that Data Protector
is installed.

The Data Protector post script could not be found in the RMC-S
installation folder.

• Ensure that the dpend_notify.bat file is present in the
RMC-S installation folder.

RMS5382: ERROR: Could not find Data
Protector post script.

5382

The specified datalist could not be found or access was denied.RMS5383: ERROR: Datalist not found
or SYSTEM account does not permit

5383

• Ensure that the correct name is specified for the datalist.backup from this client. Please select
• Ensure that the SYSTEM account has permission to run

backup processes from the specified client.
<Any> while configuring the client
system.

• Use the Data Protector Manager GUI to configure client
permissions.
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Table 3 RMC-S Server Event Messages (continued)

Description/ActionEvent MessageEvent ID

Data Protector failed to execute the specified command.

• For more details, check the Data Protector logs on the Data
Protector Cell Manager server.

RMS5384: ERROR: Error encountered
while running the Data Protector
command.

5384

The Data Protector Session ID to restore was not found for
the timestamp specified.

• Ensure that the backup timestamp does not belong to
another backup vendor (for instance, Symantec NetBackup).

RMS5385: ERROR: The Data Protector
Session ID was not found in the
repository for the given timestamp.
Please ensure that the correct Vendor
Type is specified.

5385

The NetBackup policy to restore was not found for the
timestamp specified.

• Ensure that the backup timestamp does not belong to
another backup vendor (for instance, HPE Data Protector).

RMS5386: ERROR The NetBackup
policy was not found in the repository for
the given timestamp. Please ensure that
the correct Vendor Type is specified.

5386

Could not set the disk in maintenance mode because the disk
is offline.

• Ensure that the disk to be restored is online before you run
the volume restore operation.

RMS5387: ERROR: Failed to set the disk
in maintenance mode because the disk
is offline.

5387

Could not set the disk in maintenance mode.RMS5388: ERROR: Failed to set the disk
in maintenance mode.

5388

• Ensure the disk is online and can be put in maintenance
mode.

• Troubleshoot using the cluster command:
cluster res <resource-name> /maint:on

132 Event Messages



Glossary
Terms and technologies
Table 4 Terms and technologies

DescriptionTerm/Technology

Recovery Manager CentralRMC

Recovery Manager Central for MS SQL ServerRMC-S

HPE Recovery Manager Central VSS ProviderHPE RMC VSS

Volume Shadow Copy ServiceVSS

Command Line InterfaceCLI

Single Point of Connectivity KnowledgeSPOCK

This installs the agent component of RMC-S on the production serverRecovery Manager Agent
for SQL Server

To install the server component of RMC-S on the interface serverRecovery Manager for
Interface Server

Secure Socket LayerSSL

Open Virtualization FormatOVF

GUI Partition TableGPT

A part of the Microsoft SQL Server 2012 and 2014 AlwaysOn feature. It
combines both database mirroring and log shipping capabilities to enable:

Availability Group

• Multidatabase failover

• Multiple secondaries

• Application failover using virtual names

• Readable secondary

• Backup from secondary

The databases as a group can move from one node to another node
(failover) within the AlwaysOn set of nodes.

A disaster recovery solution added in Microsoft SQL Server 2012 and 2014.
The solution provides both database level and instance level availability.

AlwaysOn

A database is a collection of logical objects within a physical structure. The
physical structure consists of one or more data files, and one or more

Database

transaction log files. A database is either used by the SQL Server itself
(system database) or by an application (user database).

A logical group of cluster resources that can be moved from one node to
the other while the nodes remain operational. The cluster group can be

Cluster group

moved by the administrator, or it can be moved as a result of a cluster
resource failure.

A computer that accesses storage on a storage system.Host system

A process that takes backed-up transaction logs from a primary SQL Server
and applies them sequentially on a scheduled basis to another SQL Server

Log shipping

database. If a failure occurs, an application can be redirected to the other
server, which will be only slightly behind the primary database. Log shipping
is a means of protecting organizations if a logical or physical system failure
occurs.

MSCS are system services that make it possible to create a virtual system
consisting of multiple cluster nodes; each node is an independent physical

MSCS Microsoft Cluster
Services (MSCS)

133



Table 4 Terms and technologies (continued)

DescriptionTerm/Technology

computer and is a failover resource of other nodes in the cluster. Each node
can support one or more virtual SQL Server instances.

A Microsoft relational database system based on the client-server database
model.

SQL Server

The hardware on which a Microsoft SQL Server database system is running.SQL Server computer

A process that is initiated and controlled by the database engine (SQL
Server).

SQL Server replication

A type of database that is used internally by SQL Server.System database

System databases are created either during installation or during feature
configuration, such as the distribution database.

System databases

A database on the distributor that stores data for replication, including
transactions, snapshot jobs, synchronization status, and replication history
information. The database is created when replication is activated.

Distribution database

Master database records the system-level information, SQL Server
initialization information, and configuration settings for SQL Server. This

Master database records

database also records all login accounts and the mapping information from
the name of a database to its primary file location.

A database that is used to fulfill all temporary storage needs, including stored
procedures and tables. The tempdb database uses SQL Server during

Tempdb database

query processing and sorting, and for maintaining row versions used in
Snapshot isolation. A clean copy of the tempdb database is recreated with
its default size every time SQL Server is started.

A template for all other databases on the system, including the tempdb
database. When a database is created, the first part of it is created as a

Model database

copy of the contents of the model database. The rest of the database is
filled with empty pages. The model database must exist on the system
because it is used to recreate tempdb every time SQL Server is started.
You can alter the model database to include user-defined data types, tables,
and so on. If you alter the model database, every database you create has
the modified attributes.

A database that holds tables that SQL Server Agent uses for scheduling
jobs and alerts and for recording operators (those assigned responsibility

MSDB database

for jobs and alerts). This database also holds tables used for log shipping
and for backup and recovery.

A file that is used as a write-ahead log. All transactional operations are
recorded in the transaction log; a transaction is considered committed when

Transaction log

the 'commit' transaction record has been written to the transaction log. The
main purpose of the transaction log is for crash consistency; if there is a
system crash, power failure or similar disastrous event, then the transaction
log has enough information to roll forward all committed transactions and
roll back all noncommittal transactions.

A database created for and used by an application is considered to be a
user database.

User database

The set of servers (nodes) on which AlwaysOn is configured. The nodes
do not share disks and each node must have an SQL Server instance.

Windows Server Failover
Cluster (WSFC)
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